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Information

Notice
OMRON products are manufactured for use by a trained operator and only for 
the purposes described in this manual.

Visual aids
The following conventions are used to classify and explain the precautions in 
this manual. Always heed the information provided with them.

The following headings appear in the left column of the manual to help you 
locate different types of information.

Trademarks
Trajexia is a registered trademark of OMRON.
MECHATROLINK is a registered trademark of Yaskawa Corporation.
EtherCAT is a registered trademark of Beckhoff Automation GmbH 
(Germany). EtherCAT technology is protected by patents.
All other product names, company names, logos or other designations 
mentioned herein are trademarks of their respective owners

Copyright
Copyright © 2011 OMRON
All rights reserved. No part of this publication may be reproduced, stored in a 
retrieval system, or transmitted, in any form, or by any means, mechanical, 
electronic, photocopying, recording, or otherwise, without the prior written 
permission of OMRON.
No patent liability is assumed with respect to the use of the information 
contained herein. Moreover, because OMRON is constantly striving to improve 
its high-quality products, the information contained in this manual is subject to 
change without notice. Every precaution has been taken in the preparation of 
this manual. Nevertheless, OMRON assumes no responsibility for errors or 
omissions. Neither is any liability assumed for damages resulting from the use 
of the information contained in this publication.

Warning: 
Indicates information that, if not heeded, could possibly result in serious injury 
or loss of life.
Caution: 
Indicates information that, if not heeded, could possibly result in minor or 
relatively serious injury, damage to the product or faulty operation.

Note: Indicates information of particular interest for efficient and convenient 
operation of the product.
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SECTION 1
Introduction

1-1 Introducing CX-Motion Pro
CX-Motion Pro is a software tool designed to develop complete solutions for 
motion control devices, or devices for short. CX-Motion Pro provides tools to 
develop motion applications, configure devices, communicate with devices 
and monitor and debug motion programs that are running on devices.

1-1-1 Highlights
The following lists the highlights of CX-Motion Pro:

• Microsoft Visual Studio-style IDE
CX-Motion Pro has one single user interface where the user can perform 
all actions to develop motion applications, execute them on a device and 
adjust and optimise them. This user interface is an IDE (integrated 
development environment) that has the look and feel of the Microsoft 
Visual Studio-style IDE. Users that know the Microsoft Visual Studio IDE 
can work with the CX-Motion Pro IDE without problems.

• Solutions for multiple devices
CX-Motion Pro supports the development for several devices at the same 
time, integrated in one single solution.

• Flexible development
CX-Motion Pro offers flexible options for the development of motion 
applications. The hardware and software characteristics of motion axes 
are separate, which means that your motion application can be developed 
hardware-independent.

• Support for existing motion applications
CX-Motion Pro can import Motion Perfect 2 projects. Therefore, you can 
use your existing motion applications in CX-Motion Pro.

• Communicate with online devices
CX-Motion Pro can communicate with online devices, which are devices 
connected to the computer on which CX-Motion Pro runs.

1-1-2 Intended audience
This documentation is intended for designers, developers and testers of 
motion applications. They must have a good knowledge of the concepts of 
motion control, devices and the BASIC programming language.

1-2 This documentation
This documentation contains the following sections.

Section Contents

1 What is CX-Motion Pro, who is it for, what do you need to use it

2 The CX-Motion Pro user interface, its windows, how to use it, and 
how to adjust it to your preferences

3 The items to develop a motion application

4 How to execute motion applications, how to monitor their 
execution
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1-3 Installation

1-3-1 System requirements
CX-Motion Pro is a Microsoft Windows application. The minimum versions of 
Microsoft Windows that CX-Motion Pro supports are:

• Windows XP SP3
• Windows Vista Business Edition
• Windows 7 Home Premium

CX-Motion Pro supports both 32-bit and 64-bit versions of these operating sys-
tems.
The table below lists the system requirements for the computer on which you 
install CX-Motion Pro.

1-3-2 Installing CX-Motion Pro
The CX-Motion Pro installer is a standard InstallShield wizard. To start the 
installer, execute setup.exe, which is located in the CX-Motion Pro installer 
folder. The InstallShield wizard guides you through the installation process.
The following remarks are important when you install CX-Motion Pro:

• You must have administrator privileges on the computer where you want 
to install CX-Motion Pro.

• If you have a CX-Motion Pro licence code, you can enter it when you 
install CX-Motion Pro. If you do not have a licence code, you can still install 
CX-Motion Pro. For more information on the registration of CX-Motion Pro 
and licence codes, refer to section 1-3-3.

5 How to solve problems in a motion application, how to optimise 
the motion application

A An overview of all keyboard shortcuts in the code editor

Section Contents

Item Windows XP Windows Vista or 7

Minimum Recommended Minimum Recommended

Processor 333 MHz 
Pentium II or 
compatible

1 GHz Pentium 
III or compatible

As recommended by Microsoft

RAM 256 MB 512 MB 512 MB 1 GB

Hard disk space 512 MB (including CX-Server)

Display SVGA
800 x 600
256 colours

XGA
1024 x 768
16 mill. colours

SVGA
800 x 600
256 colours

XGA
1024 x 768
16 mill. colours

Media drive CD-ROM drive

Communication ports
• Ethernet, for connection to TJ1-MC04, TJ1-MC16, TJ2-MC64 or CJ1 or CJ2 PLC 

with CJ1W-MCH72 or CJ1W-MC472
• RS232, for connection to CJ1 or CJ2 PLC with CJ1W-MCH72 or CJ1W-MC472
• Other, for connection to CJ1 or CJ2 PLC with CJ1W-MCH72 or CJ1W-MC472 

(refer to the CJ1/CJ2 hardware manual)



Document conventions SECTION 1 Introduction

3

• You can select which applications you want to install in the Select 
Features window:

• CX-Drive
CX-Drive is a configuration tool for drives. CX-Motion Pro needs CX-
Drive to perform drive tuning (see section 3-5-4-1).

• CX-Server
CX-Server is middleware to communicate with other OMRON 
components. CX-Motion Pro needs CX-Server to communicate with 
an online device (see section 3-2-3).

• CX-Motion Pro
CX-Motion Pro is the main application.

• If CX-Server is installed, it can be required to restart your computer after 
the installation. This depends on several factors, such as the operating 
system. If a restart is required, the CX-Motion Pro installer indicates that.

1-3-3 Registering CX-Motion Pro
The CX-Motion Pro software can run in 2 modes:

• Trial mode
In trial mode, CX-Motion Pro runs 30 days after the installation. After 30 
days, it stops working.

• Full mode
In full mode, CX-Motion Pro has no duration limitation.

You can register CX-Motion Pro with a licence code. The licence code consists 
of 4 groups of 4 digits. The following registrations are available:

You can register CX-Motion Pro during the installation, or in CX-Motion Pro: 
select About... on the Help menu, and click Upgrade Licence...

1-4 Document conventions
This documentation uses the following typographical conventions:

Licence code CX-Motion Pro mode

None Trial mode

Trial licence Trial mode

Full licence Full mode

Typography Description

FOR i=0 to 10

    SPEED = i

NEXT i

This font is used for BASIC program code

GLOBAL "ratio", 23 Bold words in syntax descriptions are words that 
must be typed literally

Solution Explorer Bold words in other text are used to indicate the 
names of user interface elements

solution-item-1 Italic words in syntax descriptions or names of 
user interface elements are placeholders for 
other text

CTRL Capital letters are used for the names of keys
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1-5 Getting help
To view this documentation in CX-Motion Pro, you can press F1 or select 
Help... on the Help menu.
The BASIC code editor offers context-sensitive help on BASIC keywords. To 
open the context-sensitive help on a BASIC keyword, place the cursor on a 
BASIC keyword in the code editor and press F1.

CTRL+TAB A plus sign (+) between 2 keys indicates a 
combination of keys that are pressed at the 
same time

Typography Description
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SECTION 2
Integrated Development Environment

2-1 Introduction
The CX-Motion Pro IDE provides the tools you need to develop a motion 
application, such as a code editor, data entry windows, a compiler and a 
debugger.

CX-Motion Pro IDE

The behaviour and appearance of the CX-Motion Pro IDE can be customised 
to your personal preferences.

2-1-1 Window types
The CX-Motion Pro IDE contains 2 types of windows:

• Document windows
Document windows are dynamically created when you edit a solution item 
in CX-Motion Pro.

• Docking windows
The docking windows are predefined and statically created. They contain 
tools and feedback on the solution items and on the document windows. 
Docking windows are described in section 2-4.

Document windows and docking windows behave in a different way. 
Therefore, they cannot be grouped together in the IDE.
Some windows or user interface elements in CX-Motion Pro have specific 
features. These are:

• Code editor
The code editor is a text editor with advanced features such as code 
completion and syntax colouring. It is used to edit BASIC program code. 
The code editor is described in section 2-2.

• Tabular views
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A tabular view is a table of values in rows and columns, with special 
sorting and filtering features. Tabular views are described in section 2-3.

2-1-2 Layout
The CX-Motion Pro IDE supports 2 different layouts:

• Multiple-document view
In the multiple-document view, the CX-Motion Pro main window is the 
parent window and the document windows are child windows. In this view, 
the CX-Motion Pro IDE has a Window menu that lists all open child 
windows. The child windows can be tiled and cascaded. You can use 
CTRL+F6 to move the focus to the next document window.

Multiple-document view

• Tabbed view
In the tabbed view, all open document windows are grouped together in 
one single child window, which has a tab for each document window. In 
this view, there is no Window menu. You can use CTRL+TAB to move the 
focus to the next document window.

Tabbed view

To change the layout of the CX-Motion Pro IDE, select Multiple Document 
View on the View menu. This toggles the layout between the multiple-
document view and the tabbed view. The check mark on this menu item 
indicates that the current layout is the tabbed view. This is the default layout of 
the CX-Motion Pro IDE.

Note: The layout of the CX-Motion Pro IDE has no influence on the behaviour of the 
docking windows.
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2-2 Code editor
The code editor is a text editor to write BASIC program code. It consists of the 
following areas:

• Margin bar
This is the gray vertical bar at the left of the code editor. It contains the 
icons that indicate a bookmark or a breakpoint.

• Line number area
The line number area is a column of white space right of the margin bar. 
It contains the line numbers.

• Left margin indicator
This is a dotted vertical line at the right side of the line number area. It 
indicates the left margin of the text area. Also, it indicates the parts of the 
program code that are built (with a green bar) or changed (with a yellow 
bar). Refer to section 2-2-5-2.

• Text area
This is the area where you type the text.

• Right margin indicator
This is a dotted vertical line at the right side of the text area. It indicates 
the right margin of the text area.

Code editor

The code editor has several features that make writing and editing program 
code very easy. These features are described in the following subsections.

2-2-1 Editing text

2-2-1-1 Standard operations
The code editor supports the standard text editor operations. The table below 
lists the standard operations. The second column lists the corresponding 
commands on the Edit menu.

Note: If you click on a line number, the entire line is selected.

Operation Command

Undo or redo the last operation Undo, Redo

Cut, copy or paste the selected text Cut, Copy, Paste

Delete the character right of the cursor or the selected 
text

Delete
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2-2-1-2 Indenting text
You can increase or decrease the indent of one or more lines of code with the 
Increase Line Indent and Decrease Line Indent commands under 
Advanced on the Programs menu. These commands apply to the selected 
lines in the code editor, or to the current line1 if no text is selected.

You can also increase the indent with the TAB key, and decrease the indent 
with the SHIFT+TAB keys.

CX-Motion Pro gives feedback about the indentation with gray vertical lines in 
the text area that connect lines of code with the same indentation.

Indentation lines

2-2-2 Navigating

2-2-2-1 Line number
You can navigate directly to a specific line in the code editor. To do this, select 
Go To on the Edit menu, enter the line number to navigate to in the Go To 
Line window and click OK.

Go To Line window

2-2-2-2 Bookmarks
A bookmark is a marker that specifies a line in the code editor. It is indicated 
with a bookmark icon  in the margin bar of the code editor. CX-Motion Pro 
supports navigation between bookmarked lines in the code editor.
The table below lists the actions that CX-Motion Pro supports for bookmarks in 
the code editor. The second column lists the corresponding commands on the 
Programs menu, under Bookmarks.

Select all text in the code editor Select All

Operation Command

1. The current line is the line where the cursor is.

Note: If you increase a line indent, CX-Motion Pro inserts 4 space characters to the 
beginning of the line. It does not insert a tab character.

Note: The TAB and SHIFT+TAB keys only increase or decrease the indent of the 
current line if the cursor is before the first non-space character on the line.
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2-2-2-3 Breakpoints
Breakpoints are used to debug program code. For information about 
navigation between breakpoints in the program code and breakpoints in 
general, refer to section 5-2.

2-2-3 Searching text

2-2-3-1 Search and replace
CX-Motion Pro supports search and replace operations for text in programs in 
code editor windows. The incremental search operation works directly in the 
code editor. It is described in the next section (2-2-3-2). The standard search 
and replace operations are accessible from the Find and Replace window.

Find and Replace window

To show the Find and Replace window, select Find and Replace on the Edit
menu, and then Find and Replace. The Find and Replace window is a 
docking window. For more information on docking windows, refer to section 2-
4.
The 3 basic elements of a search and replace operation are the find string, the 
replace string and the search scope:

• The find string is entered in the Find what field. This field has a drop-down 
list with the recent find strings.

• The replace string is entered in the Replace with field. This field has a 
drop-down list with the recent replace strings. If you want to do a search 
without a replace, leave this field empty.

• The search scope is selected in the Look in list. Select Current Program
to search only in the code editor window that is currently active. Select All 
Programs to search in all open code editor windows.

The table below lists the search actions that CX-Motion Pro supports. The 
second column lists the corresponding buttons in the Find and Replace
window.

Action Command

Set a bookmark on the current line Toggle Bookmark

Clear the bookmark from the current line Toggle Bookmark

Clear all bookmarks Clear Bookmarks

Navigate to the next bookmark Next Bookmark

Navigate to the previous bookmark Previous Bookmark

Note: If you select All Programs, you cannot do a replace. The Replace with 
field and the Find Next, Replace and Replace All buttons are disabled. 
You can only list all occurrences of the find string in the Find Results 
window.
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CX-Motion Pro supports many search options. The table below lists the search 
options. The second column lists the corresponding check boxes in the Find 
and Replace window.

To search for a regular expression or a wildcard, select the Use check box and 
select Regular expressions or Wildcards in the list. If you search for a 
regular expression, certain characters in the find string represent notations for 
text patterns. If you search for wildcards, certain characters in the find string 
represent a class or a sequence of characters. Click the > button next to the 
Find what edit field to insert a regular expression character or a wildcard 
character.

2-2-3-2 Incremental search
The incremental search operation searches the text while you type the find 
string. Incremental search works directly in the text editor. You cannot do 
normal text editing in the code editor when you do an incremental search.

Action Button

Find the next occurrence of the find string Find Next1

1. You can also select Find Next under Find and Replace on the Edit menu. 
This menu is also available outside the Find and Replace window.

Replace the found occurrence of the find string with 
the replace string

Replace

Show a list of all occurrences of the find string in the 
Find Results window

Find All

Replace all occurrences of the find string in the 
current code editor window with the replace string

Replace All

Show a list of all occurrences of the find string in the 
Find Results window, and mark all occurrences of the 
find string with a green squiggle and optionally a 
bookmark

Mark All

Clear all green squiggles that mark the occurrences of 
the find string2

2. To clear all bookmarks, select Bookmarks on the Edit menu and then 
Clear Bookmark.

Clear Marks

Search option Check box

Search for occurrences of the find string that match 
the uppercase and lowercase characters in the find 
string

Match case

Search for whole words only and ignore occurrences 
of the find string within a word

Match whole word

Change the search direction to up from the cursor 
position up

Search up

Also search in hidden outlines in the text Search hidden text

Search only in the selected text in the code editor Search in selection

Mark all occurrences of the find string with a 
bookmark

Mark with bookmarks

Search for regular expressions or wildcards (see 
below)

Use
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The table below lists the actions that CX-Motion Pro supports for incremental 
search. The second column lists the keys to do these actions.

2-2-4 Inserting and editing code

2-2-4-1 Commenting code
Comments are texts in the code editor that are not part of the program code. 
They are ignored when the program is built. Comments are useful when you 
want to add an explanation to your program code.
In BASIC, a comment is indicated by a comment mark. This is a single 
quotation mark ('). All the text from the comment mark to the end of the line is 
comment.
You can add or remove comment marks to one or more lines with the 
Comment Selection and Uncomment Selection commands under 
Advanced on the Programs menu. These commands apply to the selected 
lines in the code editor, or to the current line if no text is selected.

2-2-4-2 Inserting a command
CX-Motion Pro can insert a BASIC command in the program. This is useful if 
you do not know the correct name or syntax of a command.
You can insert BASIC command with the Insert Command... command on the 
Programs menu. This shows the list of available BASIC commands. This list 
supports incremental search, which means that you can type the first letters of 
the command, and the selection in the list scrolls to that command. To insert 
the selected command, double-click it or press ENTER or TAB.

Insert command

2-2-4-3 Inserting a code snippet
A code snippet is a piece of predefined code that you can insert in your 
program. The advantage of a code snippet is that you do not have to type the 
code manually, which saves you work and avoids syntax errors in the code.

Action Keys

Start an incremental search CTRL+I

Find a string Type the string

Find the next occurrence of the find string CTRL+I

Find the previous occurrence of the find string CTRL+SHIFT+I

Cancel the incremental search ESC

Note: When you perform an incremental search, the mouse pointer changes to  
or  (the arrow indicates the search direction).

Note: The command Uncomment Selection only removes the comment marks that 
are at the start of the line. Comment marks that are not at the start of the line 
are not removed.

Note: The shortcut key for Insert Command... is CTRL+SPACE.
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CX-Motion Pro supports code snippets for these conditional commands and 
loop commands:

You can insert a code snippet with the Insert Code Snippet... command on 
the Programs menu. This shows the list of available code snippets. To insert 
the selected code snippet, double-click it or press ENTER or TAB.

Insert snippet

A code snippet consists of BASIC keywords and code snippet fields. The code 
snippet fields are placeholders for the expressions, variables and statements 
that must be inserted to make the code syntactically correct. For example, the 
REPEAT code snippet inserts the following code:
REPEAT

statement

UNTIL expression

In this code snippet, statement and expression are code snippet fields. They 
are placeholders for one or more BASIC statements and a BASIC expression 
respectively. A code snippet field shows in a specific colour, and it has an 
associated tooltip that shows if the mouse pointer hovers over the code 
snippet field.

2-2-4-4 Generating variable declarations
CX-Motion Pro requires that all local variables in a program are declared 
before they are used. If a local variable is not declared, CX-Motion Pro 
generates a warning when the program is built.
Motion Perfect 2 and the Trajexia devices do not require that local variables 
are declared. Thus, if you import a Motion Perfect 2 project in CX-Motion Pro, 
or if you transfer a program from a Trajexia device to CX-Motion Pro, you can 
have a program that has many undeclared local variables.
CX-Motion Pro has a function that automatically adds a declaration for each 
local variable to a program. You can choose this function with the Auto 
Variable Update command in the context menu of the code editor. This adds 
the declaration of all local variables to a collapsible code section in the code 
editor.

2-2-4-5 Generating SHELL code
CX-Motion Pro can generate program code for the assignment of axis 
parameters, drive parameters, Table data, VR variables and CAM table data in 
the SHELL program. For more information, refer to section 3-4-5.

Code snippet BASIC command

FOR FOR..TO..STEP..NEXT

IF IF..THEN..ELSEIF..THEN..ELSE..ENDIF

REPEAT REPEAT..UNTIL

WHILE WHILE..WEND

Note: BASIC does not have variable types. Thus, to declare a variable in a BASIC 
program you only have to initialise it, that is, assign it a value. This must be a 
numeric value, because all BASIC variables are numeric.
To declare the variable var, CX-Motion Pro adds the line var = 0 to the 
program.
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2-2-5 Visual feedback

2-2-5-1 Right margin
The right margin indicator indicates the right margin of the text area. The text 
area has a width of 80 characters. You can enter lines in the text area that are 
longer than 80 characters. However, this generates an error when you build 
this program, because BASIC code lines cannot be longer than 80 characters.

2-2-5-2 Built code and changed code
CX-Motion Pro gives feedback in the code editor about which code is built, 
and which code is changed after the last build. Code that is built is indicated 
with a green vertical line. Code that is changed after the last build is indicated 
with a yellow vertical line.

Green and yellow lines

2-2-5-3 Matching parentheses
CX-Motion Pro recognises pairs of parentheses that match. This gives you 
feedback on misplaced or missing parentheses, which cause syntax errors.
If 2 parentheses match, CX-Motion Pro highlights the 2 parentheses in the 
following cases:

• If the cursor is left of the opening parenthesis
• If the cursor is right of the closing parenthesis

Matching parentheses

2-2-5-4 Read-only sections
CX-Motion Pro can generate program code. Some sections of generated code 
are read-only and cannot be edited. The read-only sections of code have a 
gray background colour.

Read-only section

Note: If the cursor is left of an opening parenthesis or right of a closing parenthesis, 
you can press CTRL+] to navigate to the matching parenthesis.
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2-2-5-5 Syntax colouring
The BASIC program code consists of syntactical elements. The code editor 
recognises these syntactical elements when you enter the code.
You can change the colours and fonts of the syntactical elements in the 
BASIC Program Style window. To open this window, select BASIC Program 
Style under Options on the Tools menu.

BASIC Program Style window

In the BASIC Program Style window, you can set the font, the font size, the 
foreground and background colours and the character style (bold, italic and 
underlined) for each syntactical element, which are called items in this 
window.

2-2-5-6 Command information
CX-Motion Pro can show the following information about a BASIC command 
and the arguments when you type the BASIC command in the code editor:

• The number of overloads of the command (if the command has overloads)
• The arguments
• The possible values of an argument
• A description of the command

The information shows in a tooltip. The command in the tooltip is a hyperlink. If 
you click this hyperlink, the associated help information for this BASIC 
command opens.
The next argument that you must insert is highlighted in bold.

Command information

The table below lists the actions that CX-Motion Pro supports for argument 
information. The second column lists the steps to do these actions.

Note: You can copy text from a read-only section.

Note: To restore the default colours and fonts of the syntactical elements, click the 
Default button in the BASIC Program Style window.

Action Steps

View the argument information for a 
command

Type the command, and type the 
opening parenthesis, or
Put the cursor between the argument 
parentheses, and press 
CTRL+SHIFT+SPACE



Code editor SECTION 2 Integrated Development Environment

15

2-2-6 Viewing

2-2-6-1 Outlining
CX-Motion Pro supports outlining of the text in the code editor. An outline is a 
section of the text that can be visible or hidden in the code editor.

• A visible outline is indicated with a minus sign in a small square to the right 
of the left margin indicator, and a vertical line from the small square up to 
the last line of the outline.

Visible outline

• A hidden outline is indicated with a plus sign in a small square to the right 
of the left margin indicator. Instead of the outlined text, an outline 
placeholder opens. It consists of the first line of the outlined text followed 
by an ellipsis.

Hidden outline

All outlines are automatically defined by CX-Motion Pro. You cannot define 
your own outlines, or clear existing outlines.
The table below lists the actions that CX-Motion Pro supports to show or hide 
outlines. The second column lists the corresponding commands on the 
Programs menu, under Outlining.

View the argument information for 
another overload of the command

Press the ARROW UP or ARROW 
DOWN key to scroll through the list of 
overloads

Show information about the next 
argument in the argument list

Type a value for the current argument, 
and type a comma

Close the argument information tooltip Press ESC, or complete the command 
with all arguments and type the 
closing parenthesis

Action Steps

Note: Outlined text is not deleted when you hide it, it is only invisible in the code 
editor.

Note: If you hover the mouse pointer over a hidden outline, a tooltip with the 
hidden text opens. If the hidden text is very large, only the first part of the 
hidden text shows in the tooltip.

Action Command

Show a hidden outline Toggle Outlining
(Or click the plus sign in the small square of the 
outline)
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2-2-6-2 Splitting the window
You can split the code editor window. If you split the window, you can look at 
different parts of the same window simultaneously. This is useful if you want to 
compare different parts of the code in the same program.
You can split the window horizontally and vertically. To split the window, drag 
or double-click the horizontal or the vertical splitter. The horizontal splitter is 
located left of the horizontal scroll bar. The vertical splitter is located above the 
vertical scroll bar.

Split code editor

2-2-7 Shortcut keys
The code editor supports many shortcut keys to edit the text and navigate 
through the text. Refer to appendix A for an overview of all shortcut keys in the 
code editor.

2-3 Tabular views
A tabular view is a user interface element that shows a table of values 
arranged in rows and columns. CX-Motion Pro uses tabular views to show the 
following items:

• Constants
• I/O memory
• CAM tables
• VR memory
• Table memory
• Watches
• Memory areas in the Memory Manager

Hide a visible outline Toggle Outlining
(Or click the minus sign in the small square of the 
outline)

Show all outlines Expand All Outlining

Hide all outlines Collapse All Outlining

Action Command
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Tabular view

The tabular views have the same layout, and they have a set of features, 
which are described in this section. Not all tabular views have the same 
features. For each feature, we list to which tabular views it applies.

2-3-1 Change a value in a cell
There are 2 ways to change the value in a cell: you can edit a cell, or paste on 
a cell.

Edit cell To edit a standard cell, do the following:
1. Select the cell that you want to edit.
2. Click in the cell, or press F2.
3. Type a new value in the cell.
4. Press ENTER.

Edit drop-down cell To edit a drop-down cell, do the following:
1. Select the cell that you want to edit.
2. Click the drop-down arrow in the cell.
3. Select a new value in the drop-down list.

Paste cells To paste one or more table cells, do the following:
1. Copy one or more cells to the clipboard.
2. Select a cell in the tabular view where you want to paste the cell(s) on the 

clipboard.
3. On the Edit menu, select Paste.

The table below lists the columns in which the cells can be edited.

Note: If you press ESC instead of ENTER in this step, the new value is 
discarded and the old value restored.

Tabular view Columns

Constants Name
Value

I/O Description

CAM table Value

VR memory Global Name
Usage

Table memory All columns except Address
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2-3-2 Sorting a column
Some columns can be sorted. If you click on the column header, the column is 
sorted in ascending order. A triangle shows at the right side of the column 
header that indicates the sort order.

Column header with ascending sort order triangle

If you click on the header of a column that is sorted in ascending order, the 
column is sorted in descending order.

The table below lists the columns that can be sorted.

2-3-3 Filtering rows
Some columns can have a filter. If you set this filter, the table only shows the 
rows where the value of the cell in the filtered column is equal to the column 
filter.
If a column can have a filter, a filter button shows when the mouse pointer is 
over the column header.

Column header with filter button

Set filter To set a filter, do the following:
1. Click the filter button on the column header.
2. Select a value from the list of filter values.

Some filters have special filter values that can be selected. The table 
below lists these special filter values.

Note: Not all columns can be sorted. If you click on the header of a column that 
cannot be sorted, the column is selected.

Tabular view Columns

Constants Name
Value

I/O memory Address
Type
Description
Device

VR memory Address
Global Name
Usage
Value

Watch window All

Special filter 
value

Description

(Custom) A custom filter 

(Blanks) Blank characters (spaces and tabs)

(Non blanks) Non-blank characters (all characters except blank 
characters)
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If a column has a filter set, the filter button on the column header shows 
permanently, in purple.

Filter button in purple

Set custom filter To set a custom filter, do the following:
1. Click the filter button on the column header.
2. Select the value (Custom) from the list of filter values.

Custom AutoFilter window

3. In the Custom AutoFilter window, enter a relation and a value for the 
filter.

4. Optionally, enter another relation and value for the filter, and a boolean 
relation (AND or OR) between the first relation and value and the second 
relation and value.

5. Click OK.

Clear filter To clear a filter, do the following:
1. Click the filter button on the column header.
2. Select (All) from the list of filter values.

The table below lists the columns that can have a filter.

2-3-4 Importing and exporting data
The data in some tables can be imported from a file and exported to a file. To 
do this, right-click in the tabular view, and select Import data..., or select 
Export data...
The file to import from or export to is in CSV format. If the size and values of 
the data in the CSV file do not match the size and value formats of the data in 
the tabular view, CX-Motion Pro shows an error message.
The table below lists the tabular views of which the data can be imported and 
exported.

(All) All values (used to clear a filter)

Special filter 
value

Description

Tabular view Columns

I/O memory Type
Device

VR memory Usage

Watch window Type
Device
Group
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2-4 Docking windows
The docking windows are windows that show information about the solution, 
the solution items and the contents of the document windows, and they 
provide tools and options to support working with CX-Motion Pro.
Docking windows do not behave like document windows, but they have 
different display characteristics. These are described in the next section.

2-4-1 Arranging docking windows
The docking windows are listed on the View menu, under Docking Windows. 
A check mark on the menu item indicates that the corresponding docking 
window is visible. You can hide or show a docking window with these menu 
commands.
In addition, CX-Motion Pro supports the following layout operations on docking 
windows:

• Show or hide the docking window automatically
• Dock a docking window against an edge of the IDE, or float a docking 

window over the IDE
• Group docking windows together, or detach grouped docking windows

2-4-1-1 Showing or hiding a docking window automatically
CX-Motion Pro supports the auto-hide feature for docking windows. If this 
feature is on, the window is minimised to a tab at the edge of the IDE if it does 
not have the focus. The window shows when the mouse pointer is over the tab 
or in the window.

Set auto-hide To set the auto-hide feature of a docking window, do the following:
1. If the window floats, dock it.
2. Click the pushpin in the title bar.

Pushpin

Clear auto-hide To clear the auto-hide feature of a docking window, do the following:
If the window does not show, click on the tab at the edge of the IDE to make it 
visible.

1. Click the pushpin in the title bar.
2.

Pushpin

Tabular view

Constants

CAM table

VR memory

Table memory

Note: The auto-hide feature only works if the window is docked.
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2-4-1-2 Docking or floating a docking window

Dock window To dock a docking window against an edge of the IDE, do the following:
1. Drag the window away from its current location.

Four single-arrow guide shows, at the 4 edges of the IDE.

Four single-arrow guides

If the mouse pointer is over a document window, an additional four-arrow 
guide shows in the centre of the document window. The 4 arrows point to 
the 4 edges of the document window.

Four-arrow guide for document windows

If the mouse pointer is over a docking window, an additional two-arrow 
guide shows in the centre of the docking window. The 2 arrows point to the 
2 sides of the docking window.

Two-arrow guide for docking windows

2. Drag the window to the arrow that points to the edge where you want to 
dock it.
An outline of the window location shows in the IDE at the proposed 
location.

3. Release the mouse button.
The window is docked at the proposed location.

Float window To float a docking window over the IDE, do the following:
1. Drag the window to the desired location.
2. Make sure that the mouse pointer is not over an arrow in an arrow guide.
3. Release the mouse button.

2-4-1-3 Grouping or detaching docking windows

Group windows To group a docking window together with other docking windows, do the 
following:

1. Drag the window to another docking window with which you want to group 
it.
The two-arrow guide shows in the centre of the docking window. Between 
the 2 arrows is an area that represents the grouping option.

Note: If you double-click in the title bar of a floating docking window, the window is 
docked at its previous docking location.

Note: If the auto-hide feature is set, you cannot dock the window.

Note: If you double-click in the title bar of a docked docking window, the window 
floats at its previous location.

Note: A window that floats always shows on top of the IDE and the document 
windows.

Note: If the auto-hide feature is set, you cannot float the window.
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Two-arrow guide with grouping option area between the 2 arrows

2. Drag the window to the grouping option area.
3. Release the mouse button.

The window is added as a tab to the docking window.

Detach window To detach a docking window from a group of docking windows, do the 
following:

1. Drag the tab that represents the window away from the docking window.
2. To dock or float the window, do the corresponding docking or floating 

procedure described above.

2-4-2 All docking windows
CX-Motion Pro has 8 docking windows:

• Build
• Error Log
• Find Results
• Find and Replace
• Output
• Solution Explorer
• Properties
• Watch

This section describes the docking windows.

2-4-2-1 Build window
The Build window lists the errors and warnings that CX-Motion Pro generates 
when you build a program, a device or the solution. The difference between an 
error and a warning is that an error is more severe. You can synchronise a 
device with build warnings and build errors, but is recommended not to 
synchronise a device with build errors. For more information on 
synchronisation, refer to section 4-5.

Build window

The Build window has a list that shows the following columns:

Note: If the auto-hide feature is set, you cannot group the window.

Column Description

First column
(unlabeled) An icon that indicates an error  or a warning 

Second column
(unlabeled)

The order in which the errors and warnings are generated

Description An explanation of the error or warning
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The table below lists the actions that the Build window supports. The second 
column lists the steps to do these actions.

2-4-2-2 Error Log window
The Error Log window lists all errors that occur in the online device. These 
errors are communication errors, synchronisation errors, or other errors from 
the device.

Error Log window

The Error Log window has a list that shows the following columns:

Device The device where the error or warning occurred

Program The program where the error or warning occurred (only 
applicable to syntax errors and warnings in program code)

Line The line number in the program where the error or warning 
occurred (only applicable to syntax errors and warnings in 
program code)

Source Code The code at the line number in the program where the error 
or warning occurred (only applicable to syntax errors and 
warnings in program code)

Action Steps

Navigate to the syntax error or 
warning in the code editor

Double-click the row in the list

Navigate to the previous or next 
syntax error or warning in the code 
editor

Right-click the row in the list and select 
Previous Error or Next Error

Show or hide a column in the list RIght-click on the list, select Show 
Columns and then the column you 
want to show or hide

Copy the contents of the list to the 
clipboard

Right-click on the list and select Copy

Filter the list to show or hide errors or 
warnings

Click the Errors or Warnings toggle 
button to set or clear the filter

Column Description

Note: When an error occurs, an indicator flashes on the status bar. If you double-
click this indicator, the Error Log window opens. 

Column Description

Type Error or warning

Date The date that the error occurred

Time The time that the error occurred

Source The operation or the service that generated the error
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The table below lists the actions that the Error Log window supports. The 
second column lists the steps to do these actions.

2-4-2-3 Find Results window
The Find Results window lists the results of the last Find All or Mark All
action in the Find and Replace window (refer to section 2-2-3-1).

Find Results window

The table below lists the actions that the Find Results window supports. The 
second column lists the steps to do these actions.

2-4-2-4 Find and Replace window
The Find and Replace window provides tools to search for text in the code 
editor windows and replace it. Refer to section 2-2-3-1 for information on how 
to search and replace text.

Event The error message from the source

Column Description

Note: The errors that show in the Error Log window are also appended to a file 
called ErrorLog.log. When ErrorLog.log is larger than 100 kB, it is copied to a 
backup file called ErrorLogBackup.log (which overwrites the previous version 
of ErrorLogBackup.log if it exists), and the contents of ErrorLog.log is cleared.

Action Steps

Show or hide a column in the list Right-click on the list, select Show 
Columns and then the column you 
want to show or hide

Copy the contents of the list to the 
clipboard

Right-click on the list and select Copy

Remove all errors from the list and 
clear the contents of the file 
ErrorLog.log

Right-click on the list and select Clear

Note: When you close CX-Motion Pro:
• The contents of the Error Log window is cleared 
• The contents of ErrorLog.log is not cleared

Action Steps

Navigate to the find result in the code 
editor window

Double-click the line in the window

Copy the contents of the list to the 
clipboard

Right-click on the list and select Copy

Remove all find results from the list Right-click on the list and select Clear
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2-4-2-5 Output window
The Output window shows the status information when CX-Motion Pro 
performs a process. For example, when CX-Motion Pro builds a program, a 
device or a solution, the status of the build process shows in the Output
window.

Output window

The table below lists the actions that the Output window supports. The 
second column lists the steps to do these actions.

2-4-2-6 Solution Explorer window
The Solution Explorer window shows the structure of the solution. For more 
information on the solution and the Solution Explorer, refer to section 3.

2-4-2-7 Properties window
The Properties window shows the design-time properties of the objects 
selected in the document windows or in the Solution Explorer. The properties 
can also be changed in the Properties window.

Properties window

The Properties window has a list with 2 columns: the property name, and the 
value of the property. The window supports 2 views:

• Categorised view
This view lists the properties and their values grouped together by 
category. Categories can be collapsed and expanded, to reduce or 
increase the number of visible properties. To collapse or expand a 
category, click the minus or plus sign left of the category description.
The categories are listed alphabetically. The properties in a category are 
also listed alphabetically

Action Steps

Copy the contents of the list to the 
clipboard

Right-click on the list and select Copy

Remove all lines from the list Right-click on the list and select Clear
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To show the properties in categorised view, click the  button.
• Alphabetical view

This view lists all properties in alphabetical order.
To show the properties in alphabetical view, click the  button.

The Properties window has different types of edit fields, depending on the 
value type and the list of possible values of the property. The table below lists 
the types of edit fields and the ways to enter a value in these edit fields.

Properties that show in gray are read-only and cannot be edited.

2-4-2-8 Watch window
A watch is a variable and its value. You can define watches to view the values 
of the variables when a program is running. The Watch window lists the 
defined watches.

Watch window

The Watch window has 2 buttons, Add... and Delete, to add and delete 
watches from the window, and it has a tabular view with the following columns:

The cells in the Type column have a drop-down list, where you can select the 
numeric format of the value in the Value column.

Edit field How to enter a value in the edit field

Standard edit 
field

Type the value in the edit field

Drop-down combo box
• Type the value in the edit field
• Open the drop-down list and select a value
• Double-click in the edit field to select the next value from the list of values

Edit field with ellipsis button
• Type the value in the edit field
• Click the ellipsis button to open a dialog box in which you can select a 

value to enter in the edit field

Column Description

Name The name of the watched variable

Value The value of the watched variable

Type The numeric format in which the value in the Value 
column shows

Device The device where the watched variable is defined

Group The program where the watched variable is defined 
and the process ID of the running program (if 
applicable)
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Type column in Watch window

The table below lists the values in the Type column and their corresponding 
numeric formats.

The list in the Watch window is a tabular view. Refer to section 2-3 for more 
information on the specific features of tabular views. For more information on 
watches, refer to section 5-4.

2-4-3 Resetting the layout

Reset layout The docking window layout can be restored to the default settings.
To reset the window layout, do the following:

1. On the Tools menu, select Options.
2. Select Reset Docking Window Layout.

2-5 Compatibility mode setting
The compatibility mode setting controls how unknown drive firmwares are 
handled within CX-Motion Pro. This enables the user to connect drives with 
unknown firmare versions to a controller and still be able to work with them 
inside of CX-Motion Pro, once they are transferred into the solution.
The default behaviour is for CX-Motion Pro to automatically select the highest 
known firmware version below that found on the drive.
There is also a special mode, currently only for R88D-KN (G5) drives, found 
under the Tools|Options|Compatibility Settings menu option. The tickbox on 
the dialog controls whether this special compatibility mode is on or not.
With this option selected, R88D-KN (G5) drives will only allow the connection if 
the first two digits of the firmware version are a match between the actual drive 
and the known firmware versions within CX-Motion Pro. If there is no match, 
then the drive will not be created in the solution when transferred from the 
device. If this is the case, then a message will be shown.
The below table provides some examples to show when the drive would be 
created, or not.

Type value Numeric format

Real Floating point (4 decimals)

Int Integer

Bool Boolean (0 equals False, all other values equal True)

Binary Binary representation of 24-bit integer values1

1. The Binary type does not show all 32 bits used in IEEE floating-point val-
ues.

Drive in
CX-Motion Pro

Real Drive Compatible

v1.0x v1.04 Yes

v1.0x v2.00 No

v2.0x v1.02 No
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When this option is not selected (as per default), all drives, including the 
R88D-KN, will use the highest known firmware version below that found on the 
drive.
When a drive is converted to another firmware version according to the 
compatibility rules, the user will be informed by use of an icon added to the 
drive node in the solution explorer. Also in the drive configuration window an 
icon will be added that contains a tooltip. If during synchronisation an unknown 
firmware is detected, the user will be informed by a warning.
The compatibility setting choice is saved and loaded with the solution.

v2.0x v2.01 Yes

v2.0x v2.1x No

Drive in
CX-Motion Pro

Real Drive Compatible
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SECTION 3
Solutions

3-1 Solution items
To manage the items in your motion application, CX-Motion Pro provides a 
container: the solution. The solution contains the devices in your motion 
application.
The Solution Explorer is the interface to view and manage the solution. The 
Solution Explorer shows a tree view of the items in the solution.

Solution Explorer

3-1-1 Managing solutions
CX-Motion Pro always contains one solution. CX-Motion Pro cannot contain 
more than one solution, and it cannot contain zero solutions.
When you start CX-Motion Pro, it automatically creates an empty solution. An 
empty solution is a solution without devices. When you open an existing 
solution, CX-Motion Pro closes the current solution.

New solution To close the current solution and create a new solution, do the following:
1. On the File menu, select New.
2.

Open solution To open a solution, do the following:
1. On the File menu, select Open.
2. In the Open dialog box, select the solution file.
3. Click Open.

Save solution To save an existing solution, do the following:
1. On the File menu, select Save.

To save a new solution or a copy of an existing solution, do the following:
2. On the File menu, select Save As...
3. In the Save As dialog box, specify the solution file name and the location 

to save the file.
4. Click Save.

Note: The items under a device in the solution can show in black, red and green. The 
meaning of these colours is explained in section 4-5-2.
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Protect solution You can protect the solution with a password. A protected solution is 
encrypted when it is saved. You can only open a protected solution if you have 
the password.
To protect the solution, do the following:

1. On the Tools menu, select Solution Password...
2. In the Password window, type the password in the Password text field.

Password window

3. Type the password again in the Reenter Password text field to confirm 
the password.

4. Click OK.

3-2 Devices
A solution contains devices. A device can contain data, BASIC programs, units 
and axes. CX-Motion Pro supports 2 kinds of devices:

• Motion devices
• Host devices, which contain motion devices

CX-Motion Pro supports the following devices:

Note: A solution file has the extension .tjs. The contents of the file is in XML format.
Trajexia automatically keeps a backup of the last 5 versions of the project (.tjs) 
file by appending a .1, to .5 to the filename. If a file is corrupted, these files can 
be renamed and used as a solution.

Note: If you forget the password, you cannot open the solution.
Note: Passwords are case-sensitive.
Note: To clear the password of a protected solution, set the password to the empty 

string in the Password window.

CX-Motion Pro 
name

Device Motion device/host device

TJ1-MC04 Trajexia device with 4 axes Motion device

TJ1-MC16 Trajexia device with 16 
axes

Motion device

TJ2-MC64 Trajexia device with 64 
axes

Motion device

PLC PLC (CJ1-series, CJ2-
series or CP1H-series)

Host device for the MCH72

MCH72 CJ1W-MCH72 device Motion device

MC472 CJ1W-MC472 device Motion device
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Motion devices (MCH72, TJ1-MC04 and TJ1-MC16) and host devices (PLC)

A device can be renamed (refer to section 3-8). The name of a device 
corresponds to the property Name. The property DeviceName contains the 
identifier of the device (such as PLC and TJ1-MC16). DeviceName is read-
only.

DeviceName and Name properties of a device

3-2-1 Adding a device
There are 3 ways to add a device to the solution:

• Add a new device
• Import a Motion Perfect 2 project
• Import a resource

New devices are always added after the existing devices in the solution.

Add new device To add a new device to the solution, do the following:
1. On the Insert menu, select Add device-to-add.

To add a new motion device to a host device, do the following:
2. In the Solution Explorer, select a host device.
3. On the Insert menu, select Add motion-device-to-add.

Import Motion Perfect 2 
project 

CX-Motion Pro can import Motion Perfect 2 projects into the solution. A Motion 
Perfect 2 project contains the representation of a device and its programs, 
parameters and data. CX-Motion Pro can convert a Motion Perfect 2 project to 
a device.
To import a Motion Perfect 2 project as a device in the solution, do the 
following:

1. On the File menu, select Import Motion Perfect Project...
2. In the Open dialog box, select the Motion Perfect 2 project file.
3. Click Open.

Load resource A resource is an XML file that contains a saved CX-Motion Pro device.

Note: If you select Add MCH72 on the Insert menu, a PLC host device and an 
MCH72 motion device under the PLC device are added to the solution.
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To load a resource, do the following:
1. In the Solution Explorer, right-click the Devices item.
2. Select Import Device...
3. In the Open dialog box, select the resource file.
4. Click Open.

Load a motion device from 
a resource

To load a motion device from a resource and add it to a host device, do the 
following:

1. In the Solution Explorer, right-click a host device.
2. Select Import Device...
3. In the Open dialog box, select the resource file.
4. Click Open.

3-2-2 Saving a device
You can save a device to a resource. This enables you to use the same device 
in different solutions, or use multiple instances of a device in one solution.

Save resource To save a device to a resource file, do the following:
1. In the Solution Explorer, right-click the device.
2. Select Export Device...
3. In the Save As dialog box, specify the resource file name and the location 

to save the file.
4. Click Save.

3-2-3 Configuring a device
The configuration of a device determines the following settings of the device:

• Communication settings
• General settings
• Date/time settings
• Memory settings
• PLC Memory Mapping settings (MC_72 devices only)

You can change the configuration settings in the Configuration window. To 
open the Configuration window of a device, right-click the device and select 
Configure...
If you change one or more configuration settings, you must click Apply in the 
lower right corner of the Configuration window to save the settings.

3-2-3-1 Network Settings
There are two options for the network settings:

• Simulation

Note: If the resource file does not contain a valid CX-Motion Pro device, an error 
message opens.

Note: If the resource file does not contain a motion device that can be added to the 
selected host device, an error message opens.

Note: The device in a resource file has a name. CX-Motion Pro ignores this name 
when it loads the device from the resource file. Instead, it gives the device a 
new name.

Note: You can save a device and then load it to add a copy of the device to the 
solution. However, it is more practical to copy the device with the clipboard or 
with drag-and-drop (refer to section 3-8).
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You can set up a virtual device and simulate the communication with this 
device.

• Controller
Trajexia communicates directly with an online device.
Enter the IP address of the device in the IP Address text field. For the IP 
address of the device, refer to the documentation of the device.

In the Max Attempts and Timeout text fields, you can enter the number of 
connection attempts and the timeout period in milliseconds that Trajexia uses 
to establish the communication to the online device. If Trajexia cannot 
establish the communication after the entered number of attempts or does not 
receive a response within the entered timeout period, the communication has 
failed.

3-2-3-2 Communications Settings
The communication settings of a PLC host device determine the PLC type and 
the communication network type.

• Ethernet
• FINS

FINS is an Omron protocol that can be used by a PLC program to transfer 
data and perform other services with a remote PLC connected on an 
Ethernet Network.
CX-Motion Pro uses FINS (rather than Telnet) to transfer table, VR and 
axis data, where possible. FINS is also used for the interrogation of the 
drives. The use of FINS over Telnet greatly improves the synchronisation 
delay and the monitoring rate for the affected data. 
The use of FINS is restricted by the motion device firmware. This is shown 
in the following table:

• Modbus TCP

3-2-3-3 General settings
There are 2 general settings for the device:

• Firmware version
The firmware of a device determines the supported version of the BASIC 
programming language and the supported units, axes and drives. CX-
Motion Pro comes with a set of integrated firmware versions. When you 
go online to a device that has a different firmware version, CX-Motion Pro 
uses the firmware version from the device.

Note: A slow communication or an action that takes a long time (for example, the 
command MECHATROLINK(unit,0) on an ML unit with many axes) can cause 
a timeout. With a larger Timeout value, you can resolve this problem 

Device / 
Memory-Type

TJ1-
MC04/16

CJ1W-
MC_72

TJ2-
MC64

Simulator

Table All All All None

VR 1.6714 and 
greater

All All None

Axis 
Parameter

None 1.6665 and 
greater

All None

Note: CX-Motion Pro stores different firmware versions from online devices 
locally and keeps them for future use.
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You can select a different firmware version for the device in the Firmware
list.

• Servo period
The servo period is the duration in µs of one motion cycle in the device. 
The minimum servo period of the device determines the number of 
connected axes.
You can change the servo period in the Current Servo Period text field.

Configuration window, General tab

3-2-3-4 Date/time settings
When the device is not online, the Date Time tab shows the current date and 
time of the computer. When the device is online, the Date Time tab shows the 
date and time of the online device. You can change the date and time and 
transfer them to the device.

Configuration window, Date Time tab

Note: The Firmware list is disabled when the device is online.

Note: The Current Servo Period text field is only enabled when the device is 
online.

Note: The Current Servo Period text field only shows the current servo period. 
You can change the servo period in this text field, but the change takes 
effect only after the device is reset. Until the device is reset, the value that 
shows in the Current Servo Period field is the current servo period, and 
not the changed value. CX-Motion Pro cannot show the new servo period 
value, because the new servo period can only be written to a device and 
it cannot be read.
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3-2-3-5 Memory settings
The Table memory of a motion device is a large memory for global data. It is 
used to store large amounts of data such as motion profiles or logging data. It 
can be used to create CAM tables, and data traces use it to store data real-
time.
The Table memory can be addressed with indexes. The size of the Table 
memory depends on the motion device.
The Table memory is divided in the following areas:

When you allocate Table memory to these areas, it is important to observe the 
following:

• A device has one memory, which is used for the programs and the Table 
memory. The larger the Table memory is, the less memory is available for 
programs.
Therefore, it is recommended to keep the size of the Table memory to a 
minimum.

• The Table memory is created from 0 to the largest end address. Thus, if 
you set the Shell memory area from 10,000 to 10,999, the User Table 
memory area from 20,000 to 20,999, the CAM tables memory area from 
30,000 to 30,999 and the Oscilloscope memory area from 40,000 to 
40,999, 41,000 memory slots are allocated for the Table memory, but only 
4,000 are used.
Therefore, it is recommended to allocate the 4 Table memory areas 
contiguously, and to set the start address of the first Table memory area 
to 0. 

The default Table memory allocation of a device, which is given in the table 
below, supports these recommendations.

You can change the Table memory assignment of a device in the Memory 
Manager tab on the Configuration tab.

Memory area For use by

Shell SHELL program

User Table memory SHELL program and application programs

CAM tables CAM tables

Oscilloscope Data traces

Memory area Start address End address Memory size

Shell 0 299 300

User Table memory 300 999 700

CAM tables 1,000 10,999 10    

Oscilloscope 11,000 12,999 2,000
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Configuration window, Memory Manager tab

The Memory Manager tab has a tabular view of the memory assignment. 
Refer to section 2-3-1 for information on how to edit a value in a tabular view.

The User Table Memory area overlaps the CAM Tables memory area

3-2-3-6 PLC Memory Mapping settings
The PLC Memory Mapping settings determine how the MC_72 device 
exchanges configurable data1 with its host device (PLC). For more information 
on cyclic data exchange, refer to the CJ1W-MCH72 Motion Control Unit 
Operation Manual (I55E).

Note: The start address, the end address and the memory size of a memory area are 
interdependent. If you change one of these values, and the cell with this value 
loses the focus, CX-Motion Pro changes another value:

• If you change the start address, CX-Motion Pro changes the end address.
• If you change the end address, CX-Motion Pro changes the memory size.
• If you change the memory size, CX-Motion Pro changes the end address.

Note: If the addresses of a memory area is changed, the data is not automatically 
moved. If you want to move the data, you must do this manually.

Note: If the values entered for the memory allocation are such that two memory 
areas overlap, CX-Motion Pro shows an error message when you click Apply. 
An icon  indicates the memory area that is overlapped.

1. The configurable data is all data that is exchanged except control and status 
data.
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Configuration window, PLC Memory Mapping tab

The PLC Memory Mapping tab has 2 tabs: one for the 8 output areas 
(8100..8107), and one for the 8 input areas (100..107)1. The table below lists 
the edit fields on the 2 tabs, the description and the possible values.

1. The words input and output indicate the direction starting from the MCH72 
device. Thus, output means from MC_72 to PLC, and input means from 
PLC to MC_72.

Edit field Description Possible values

PLC Area The PLC memory area 
used for data exchange

01 CIO memory

01 CIO memory

03 DM memory

04 WR memory

05 HR memory

08..14 EM memory
bank 0 hex..C hex

PLC 
Address

The start address in the 
PLC memory

The validity of this value depends on 
the value of PLC Area

TJ Area The MC_72 memory 
area used for data 
exchange

VR 16bit Int VR memory
16-bit signed integer

VR 32bit 
Float

VR memory
32-bit floating point

Digital IO IN or OP array
(depending on 
direction)

Analogue IO AIN or AOUT array
(depending on 
direction)

Axis Status Axis Status array
(only valid if direction is 
MC_72 output)

TJ Address The start address in the 
MC_72 memory

The validity of this value depends on 
the value of TJ Area
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If valid, the PLC memory mapping settings are stored in the SHELL program 
on a build, if a SHELL program exists in the solution for the relevant device.

3-2-3-7 EtherNet/IP settings
EtherNet/IP data links are supported by the TJ2-MC64. These allow PLCs 
(with an in-built EtherNet/IP unit, such as certain CJ2H and CJ2M models) to 
send data to and receive data from the JTJ2-MC64. 
The master (PLC) configuration of this is covered by Network Configurator for 
EtherNet/IP (part of CX-One). CX-Motion Pro only configures how the TJ2-
MC64 will interpret the data, where the received data will be stored and where 
the data to be sent is stored.
Both Table and VR can be used for both the received data, and the data to be 
sent back to the PLC, and the data can be stored as either 16-bit integers 
(INT16), 32-bit integers (INT32) or 32-bit floats (FLOAT32).
When VR memory areas are used for the input, a global variable is created for 
the first item. It is not possible to use VR addresses that would overlap with 
existing global variables, such as those from DRT/PRT units, or user-defined 
globals. This is not the case for outputs or Table.
The maximum possible number of items for either input or output is set to 512 
bytes worth of data (e.g. INT16 will give a maximum of 256 items, as each 
INT16 uses 2 bytes worth of data).
The following screenshot shows the general layout of the settings tab.

There are two rows, one for the input configuration, and one for the output. 
The input is the data coming from the PLC into the TJ2-MC64, and the output 
is the data sent from the TJ2-MC64 to the PLC.
The TJ area column select which area the data is to be stored/read from, and 
the start address indicates the exact position of the first item. Total number of 
items controls how many items are sent/received.
The Format columns controls which data format CX-Motion Pro will read the 
data as. Depending on the format, the maximum allowed number of items is 
different (256 for INT16, and 128 for INT32 and FLOAT32).
If 0 is set for the total number of input items, then CX-Motion Pro will not 
configure the input values, the same is true for output.
EtherNet/IP settings can be transferred to or from the controller individually 
using the relevant option in the advanced layout of the synchronisation dialog. 
The settings are always included in transfers using the basic layout.

Total Items The total number of 
items (words and 
dwords) to exchange

The validity of this value depends on 
the values of PLC Area and TJ Area

Edit field Description Possible values

Note: If the PLC type of the PLC host device is not set, you cannot set the data 
exchange values of the MCH72 device.
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If valid, the EtherNet/IP settings are stored in the SHELL program on a build, if 
a SHELL program exists in the solution for the relevant device.

3-2-3-8 Status information
The Status tab in the Configuration window shows the status of the CX-
Motion Pro communication services that are running (on the Service Status
tab), the status of the PLC host device (on the PLC Status tab; only for 
MCH72 devices) and the status of the online device (on the Device Status
tab).

Configuration window, Service Status tab

3-2-4 Building a device
When you build a device, CX-Motion Pro performs the following actions:

• Generate program code for the definitions of axis parameters, drive 
parameters, Table data, VR variables and CAM table data, and add it to 
the SHELL program (see section 3-4-5)

• Build all BASIC programs in the device (see section 3-4-5)
• Check that all axes are associated with a drive
• Check that all drives are associated with an axis

Build device To build a device, do the following:
1. In the Solution Explorer, select the device.
2. On the Build menu, select Build Device.

CX-Motion Pro builds the device. If the device has errors or warnings, they 
show in the Build window. Refer to section 2-4-2-1 for more information on the 
Build window, build errors and build warnings.

Note: Only TJ2-MC64s support EtherNet/IP data links, and only from firmware 
version v2.0083 and onwards.
Warning: 
There is no way of consistently determining the master settings. The user is 
responsible for ensuring the corresponding master settings are used. If these 
are wrong or get changed at later date, incorrect data may be transferred to 
controller memory which may or may not be used elsewhere in the solution.
Caution: 
There is no way of turning off Ethernet/IP from the controller side. The master 
controls the process and this will use the controllers settings whatever they 
may be.

Note: To build all devices in the solution, select Build Solution on the Build menu.



Global data SECTION 3 Solutions

40

3-3 Global data
Global data is data that is accessible to all programs of a motion device. This 
means that all BASIC programs of that motion device can access that data. 
CX-Motion Pro devices have 6 types of global data:

• Axis parameters
• Constants
• I/O memory
• CAM tables
• VR memory
• Table memory

Motion device with global data

3-3-1 Axis parameters
The axis parameters are the motion parameters for the axes connected to the 
device. They set and monitor the behaviour of the axes. The axis parameters 
are unique to each axis, thus all axes can work independently.

Edit axis parameters To view and edit the axis parameters of all axes connected to a device, do the 
following:
You can view and edit the axis parameters in the Axis Parameters window. To 
open the Axis Parameters window, do the following:

1. In the Solution Explorer, right-click Axis Parameters under Global 
Data.

2. Select Open.

Axis Parameters window

The Axis Parameters window has categorised list of commonly used axis 
parameters for all axes in the device. The rows show the axis parameters, the 
columns show the axes connected to the device. The axis parameters are 

Note: If you are online, you need to enable monitoring before you can edit/monitor 
the axis parameters. This can be done by pressing the glasses icon on the 
toolbar.
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grouped together in categories. The values of read-only axis parameters are 
shown in gray. The values of axis parameters that have errors are shown with 
a red background colour. Editing a cell in the categorised list in the Axis 
Parameters window is similar to editing a cell in a tabular view. Refer to 
section 2-3-1 for information on how to edit a value in a tabular view.
You can hide or show the parameters of axes in the Axis Parameters window. 
The table below lists the actions to show or hide one or more axes in the Axis 
Parameters window. The second column lists the corresponding commands 
on the shortcut menu of the Axis Parameters window.

Axis Selection window

3-3-2 Constants
A constant is a variable that is assigned a specific value that cannot be 
changed. The maximum number of constants in all BASIC programs in a 
device is 128.

Edit constants You can view and edit the constants in the Constants window. To open the 
Constants window, do the following:

1. In the Solution Explorer, right-click Constants under Global Data.
2. Select Open.

Constants window

Action Command

Hide an axis Hide Axis

Show all axes Show All Axes

Select which axes to show or hide Select Axis...1

1. This command shows the Axis Selection window, where you can move an 
axis to the Hidden Axis or the Displayed Axis list with the arrow buttons.
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The Constants window has a tabular view of all constants and their values. 
Refer to section 2-3-1 for information on how to edit a value in the Constants
window.
You can change the display precision of the values in the Value column with 
the Precision property in the Properties window.

A constant definition corresponds to the BASIC command CONSTANT. When 
the device or the solution is built, a CONSTANT command is added to a read-
only section of the SHELL program for each constant definition in the 
Constants window.

Add constant To add a constant, do the following:
1. In the last row in the Constants window, which is empty, type a constant 

name in the Name column.
2. Type a value in the Value column in the same row.

Delete constant To delete a constant, do the following:
1. In the Constants window, select the constant to delete.
2. Select Delete on the Edit menu.

3-3-3 I/O memory
The I/O memory holds the status of the inputs and outputs of the device. The 
inputs and outputs can have the status ON or OFF.

Edit I/O memory You can view and edit the I/O memory in the IO window. To open the IO
window, do the following:

1. In the Solution Explorer, right-click IO under Global Data.
2. Select Open.

IO window

The IO window has a tabular view of all inputs and outputs and their status. 
You can only edit the values in the Description column. Refer to section 2-3-1 
for information on how to edit a value in the IO window.

Note: If you change the display precision, CX-Motion Pro does not change the value, 
but only the display format of the value.

Note: If you add a constant definition to an application program with the CONSTANT 
command, a warning is generated when the program is built.

Note: The value in the Description column is not stored in the device. It is only 
stored in the solution.
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3-3-4 CAM tables
A CAM table is an area of the Table memory. It is used to read or write a set of 
positions that define a movement profile. CAM tables are used by the BASIC 
commands CAM and CAMBOX.

Add new CAM table To add a CAM table to a device, do the following:
1. In the Solution Explorer, right-click CAM Tables under Global Data.
2. Select Add Cam Table.
3. In the CAM Table Size window, enter the memory size of the new CAM 

table.

CAM Table Size window

4. Click OK.
A new CAM Table has the default name CAMTablen, where n is a sequence 
number.

Edit CAM table You can view and edit a CAM table in the CAM table window. To open the 
CAM table window, do the following:

1. In the Solution Explorer, right-click the CAM table to edit under CAM 
Tables under Global Data.

2. Select Open.

CAM table window

The CAM table window has a tabular view that shows the values of the CAM 
table. Refer to section 2-3-1 for information on how to edit a value in a CAM 
table window.
You can change the display precision of the values in the Value column with 
the Precision property in the Properties window.

The order of CAM tables in the Solution Explorer can be changed (refer to 
section 3-8). The order of the CAM tables does not have an influence on the 
Table memory allocation.

Note: If you change the display precision, CX-Motion Pro does not change the value, 
but only the display format of the value.
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3-3-5 VR memory
The VR memory is an array of global variables. These variables are called VR 
variables. The VR memory array is an indexed array. Its size is depends on 
the motion device. The VR memory is used for small amounts of global data.

Edit VR memory You can view and edit the VR memory in the VR Memory window. To open the 
VR Memory window, do the following:

1. In the Solution Explorer, right-click VR Memory under Global Data.
2. Select Open.

VR Memory window

The VR Memory window has a tabular view that has the following columns:

The columns Global Name, Value and Description can be edited. The 
columns Address and Usage are read-only. Refer to section 2-3-1 for 
information on how to edit a value in the VR Memory window.

You can change the display precision of the values in the Value column with 
the Precision property in the Properties window.

You can limit the number of rows that show in the tabular view to a user-
defined area of the VR memory with the Offset and Size properties in the 
Properties window.
The definition of the global name alias is equivalent to the BASIC command 
GLOBAL. The command GLOBAL "ratio",23 defines the variable ratio as an 
alias for VR(23). In a similar way, the definition of an alias in the VR Memory
window is reflected in the SHELL program. If you add the variable var in the 
Global Name column in the row where the Address column has value n, the 

Column Description

Address The index of the variable in the VR array

Global Name The alias for the index of the VR variable

Value The value of the VR variable

Usage The item that uses the variable (Possible values are the 
SHELL program, the PRT unit and the DRT unit)

Description A description of the VR variable

Note: The value in the Description column is not stored in the online device if it is 
synchronised. It is only stored in the solution.

Note: If you change the display precision, CX-Motion Pro does not change the value, 
but only the display format of the value.
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line GLOBAL "var",n is added to the read-only section of the SHELL 
program. For more information on generating SHELL code, refer to section 3-
4-5.
A VR variable can have an alias. This alias is a reference to the index of the 
variable in the VR array.

3-3-6 Table memory
The Table memory contains the Table variables of the device. It is used for 
large amounts of global data, such as CAM tables and data traces.

Edit Table memory You can view and edit the Table memory in the Table Memory window. To 
open the Table Memory window, do the following:

1. In the Solution Explorer, right-click Table Memory under Global Data.
2. Select Open.

Table Memory window

The Table Memory window has a tabular view that shows the values in the 
Table memory. Refer to section 2-3-1 for information on how to edit a value in 
the Table Memory window.
You can change the display precision of the values in the tabular view with the 
Precision property in the Properties window.

Because the Table memory can be large, the Table Memory window has 
some features to change the layout of the tabular view. The table below lists 
the features. The second column lists the properties in the Properties window 
that you must change to enable the features.

Note: If you change the display precision, CX-Motion Pro does not change the value, 
but only the display format of the value.

Feature Property

Change the number of columns in the tabular view Columns

Limit the values that show to a specific Table memory 
area (Shell, User Table memory, CAM tables or 
Oscilloscope) 

Table Memory 
Area

Limit the number of values that show to a user-defined 
area of the Table memory

Offset and Size
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3-4 Programs
Programs are the essential elements of devices: they drive the behaviour of 
the device and the connected axes. The programs are written in the BASIC 
programming language.

3-4-1 Program concepts
A motion application can consist of several BASIC programs. A program can 
have an influence on the execution of the other programs. For example, a 
program can start another program with the command RUN.
The results of a motion application where the programs have an influence on 
the other programs can be unpredictable and even dangerous. Therefore it is 
recommended to minimise the influence that the programs can have on other 
programs. This can be done with the following 2 recommendations:

• There is one program that can have an influence on other programs. This 
is the control program. The control program does the following:

• It starts, stops and resets the execution of other programs.
• It monitors the execution of other programs.

• All other programs are separate. They do not have an influence on other 
programs. They do not do the following:

• They do not start, stop or reset the execution of other programs.
• They do not know about the other programs except the control 

program.
To support these recommendations, CX-Motion Pro provides 2 kinds of 
programs: the SHELL program and the application programs.

• The SHELL program is intended as the control program. It does the 
following:

• The SHELL program starts, stops and resets the execution of the 
application programs.

• The SHELL program monitors the execution of the application 
programs.

• The SHELL program monitors the drive statuses.
• The SHELL program initialises the axis parameters, Table data, VR 

variables and CAM table data.
• The application programs must not have an influence on other programs. 

It is recommended that they do not do the following:
• They do not start, stop or reset the execution of application programs 

or the SHELL program.
• They do not know about the application programs. They only know 

about the SHELL program.
The SHELL program and the application programs have different 
characteristics in CX-Motion Pro:

• A motion device can have one SHELL program. It can have several 
application programs.

• The auto-generated code for a new SHELL program is very extensive. 
The auto-generated code for a new application program does only contain 
some comments, but no BASIC commands.

• CX-Motion Pro provides tools to add the code for the definitions of axis 
parameters, drive parameters, Table data, VR variables and CAM table 
data to the SHELL program. These tools are not available for the 
application programs. Refer to section 3-4-5.
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• The Solution Explorer shows the icon for the SHELL program in a 
different colour.

With these characteristics, the SHELL program provides a framework to make 
sure that your motion application follows the 2 recommendations. However, 
CX-Motion Pro does not enforce the recommendations. This means that the 
following actions are possible in CX-Motion Pro:

• The SHELL program can be deleted (refer to section 3-8). Thus, it is 
possible to have a device without a SHELL program.

• It is possible to start an application program from another application 
program.

It is recommended not to do the actions described above.
The reason that CX-Motion Pro does not enforce the recommendations is to 
provide compatibility with legacy programs and motion applications. However, 
it is strongly recommended to follow the recommendations.

3-4-2 Adding a program
When you add a new motion device to the solution, 2 programs are created by 
default: the SHELL program, and an application program called 
APPLICATION.

Default programs SHELL and APPLICATION

Add program To add a new BASIC program to a motion device, do the following:
1. In the Solution Explorer, right-click Programs under a motion device.
2. Select Add SHELL Program to add the SHELL program, or select Add 

Basic Program to add an application program.

A device can execute a program at startup: when the device is switched on, it 
executes the program.
You can set the startup priority for a program in CX-Motion Pro with the 
Priority property in the Properties window. If you click the ellipsis button in 
the edit field of this property, the StartUp Priority window opens.

StartUp Priority window

Note: CX-Motion Pro identifies the SHELL program of a motion device only by its 
name. Therefore, if you rename the SHELL program (refer to section 3-8), it 
has the characteristics of an application program (for example, the icon colour 
changes to the default colour). Similarly, if you change the name of an 
application program to 'SHELL', it has the characteristics of the SHELL 
program (for example, CX-Motion Pro provides tools to add the code for the 
definition of Table data to the program).
It is recommended not to rename the SHELL program, and not to rename an 
application program to SHELL.

Note: The Add SHELL Program menu item is disabled if the motion device 
already contains the SHELL program.
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To set the program to run at power up, select the Run at Power Up check box 
and select a priority in the list. Ranges are motion device dependent; there are 
two groups: fast and slow basic tasks. Within a group, all tasks have equal 
priority. For example, for an MC64, the groups are slow (0-19), or fast (20-21).
To set the program not to run at startup, clear the Run at Power Up check 
box.

3-4-3 Building programs

Build program To build a BASIC program, do the following:
1. Go to the code editor that contains the program code to build.
2. On the Build menu, select Build Program.

CX-Motion Pro compiles and builds the program. If the program has errors 
or warnings, they show in the Build window. Refer to section 2-4-1 for 
more information on the Build window, build errors and build warnings.

3-4-4 Printing a program

Print program To print a BASIC program, do the following:
1. In the Solution Explorer, right-click the program that you want to print.
2. Select Print Program.

3-4-5 Generating SHELL code
CX-Motion Pro can add the code for the definitions of axis parameters, drive 
parameters, Table data, VR variables and CAM table data to the SHELL 
program.

Add axis parameters To add the axis parameters of one or more axes to the SHELL program, do the 
following:

1. In the Solution Explorer, select the SHELL program.
2. Select Insert Axes... under Modify SHELL on the Programs menu.
3. In the Insert SHELL Axes window, select the check boxes for the axes of 

which you want to add the axis parameters to the SHELL code.

Insert SHELL Axes window

4. Click OK.
For each selected axis, the code for the assignment of the axis parameters is 
added under ' Axis Parameters in the ' Start Standard Section outline of the 
SHELL program.

Note: On the TJ2-MC64, the SHELL program has a default startup priority of 0, on 
the other controller this is 1.

Note: Drive parameters can only be added to the SHELL program from the Axis 
Configuration window or the Drive Configuration window. Refer to section 
3-6-7-5.
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Add Table data To add Table data to the SHELL program, do the following:
1. In the Solution Explorer, select the SHELL program.
2. Select Insert Table Data... under Modify SHELL on the Programs menu.
3. In the Insert SHELL Table Data window, enter the start and end 

addresses for the Table memory areas for which you want to generate 
SHELL code.

Insert SHELL Table Data window

4. Click OK.
For each selected Table memory area, one or more lines TABLE(start-
address,value-1,..value-n) are added under ' TABLE DATA in the ' Start 
Standard Section outline of the SHELL program. To make the TABLE
statements not too long, one TABLE statement is generated per 10 memory 
addresses.

Add VR variables To add VR variables to the SHELL program, do the following:
1. In the Solution Explorer, select the SHELL program.
2. Select Insert VR Variables... under Modify SHELL on the Programs

menu.
3. In the Insert Variables window, enter the start and end addresses for the 

memory areas for which you want to generate SHELL code.

Insert Variables window

Note:
• CX-Motion Pro does not check if the code that you want to generate is 

already in the SHELL program. If you add code for the same axis 
parameters twice, the same axis parameter assignments are in the SHELL 
code twice.

• You can change the added code.

Note:
• CX-Motion Pro does not check if the code that you want to generate is 

already in the SHELL program. If you add code for the same Table 
memory area twice, the same TABLE statements are in the SHELL code 
twice.

• You can change the added code.
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4. Click OK.
For each VR variable in the selected VR memory areas, the line VR(index) = 
value is added under ' Variables in the ' Start Standard Section outline of the 
SHELL program.

Add/remove CAM table 
data 

The code generation for CAM table data works differently than the other code 
generations, because the code for CAM table data is added to a read-only 
section of the SHELL code. This means that CX-Motion Pro can check if the 
code already exists, and it can remove the code from the SHELL program. 
The user cannot edit the CAM table data code.
To add or remove CAM table data of one or more CAM tables to the SHELL 
program, do the following:

1. In the Solution Explorer, select the SHELL program.
2. Select Insert CAM Table... under Modify SHELL on the Programs

menu.
The Insert SHELL CAM Tables window opens.

Insert SHELL CAM Tables window

If the check boxes of a CAM table has a check mark, the SHELL program 
already has the code for this CAM table. If it does not have a check mark, 
the SHELL program does not yet have the code for this CAM table.

3. Select the check boxes for the CAM tables for which you want to add the 
code to the SHELL program.

4. Clear the check boxes for the CAM tables for which you want to remove 
the code from the SHELL program.

5. Click OK.
For each selected CAM table, one or more lines TABLE(start-address,value-
1,..value-n) are added under 'OMRON Auto Generated - CAM TABLE in the 
'OMRON Auto Generated - Symbols outline (which is read-only). To make 
the TABLE statements not too long, one TABLE statement is generated per 
10 memory addresses.

3-5 Axes
An axis is a machine or a motor that controls the motion. CX-Motion Pro 
supports 4 types of axes:

• Flexible axis
A flexible axis is an axis controlled by an FL unit.

• MECHATROLINK-II axis

Note:
• CX-Motion Pro does not check if the code that you want to generate is 

already in the SHELL program. If you add code for the same VR memory 
area twice, the same VR statements are in the SHELL code twice.

• You can change the added code.
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A MECHATROLINK-II axis is an axis controlled by a MECHATROLINK-II 
Master Unit.

• EtherCAT axis
An EtherCAT axis is an axis controlled by a EtherCAT Master Unit.

• Virtual axis
A virtual axis is an axis that does not correspond to a MECHATROLINK-II 
axis or a flexible axis.

3-5-1 Axis concepts
CX-Motion Pro makes a difference between the functional characteristics and 
the hardware characteristics of axes. This makes the development of a 
solution very flexible, because it is possible to write programs that use axes 
and at the same time postpone the decision on which specific axis hardware 
you use. For example, you can add a MECHATROLINK-II servo axis to a 
motion device and write a BASIC program that uses this axis without knowing 
the hardware characteristics of this servo axis, such as the model, the address 
of the axis, and the MECHATROLINK-II unit that it is connected to. Later you 
can choose the specific axis hardware and link it to the servo axis in CX-
Motion Pro.
To reflect the distinction between the functional characteristics and the 
hardware characteristics of an axis, CX-Motion Pro supports axes at two 
levels:

• Axes
When CX-Motion Pro uses the word axis, it refers to the functional 
characteristics of an axis. These characteristics are:

• Axis type (MECHATROLINK-II, EtherCAT, flexible or virtual)
• Functionality (position, speed or torque, encoder or pulse output)

These axes show under Axes in the Solution Explorer.
• Drives connected to units

This level supports the hardware-related characteristics of an axis. These 
are:

• Hardware (servo or inverter, model, firmware version)
• The unit to which it is connected, and the port or address it uses on 

this unit
Drives are connected to units, which show under Units in the Solution 
Explorer.

3-5-2 Adding an axis

Add axis To add an axis to a motion device, do the following:
1. In the Solution Explorer, right-click Axes under a motion device.
2. Select Add Axis.
3. In the Axis Device Selection window, type a name for the axis in the Axis 

Name text field.
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Axis Device Selection window

4. In the Axis Type list, select an axis type.

5. In the Device list, select a drive to associate with the axis. If there are no 
available drives, or you do not want to associate the axis with a drive, you 
can skip this step.
Refer to section 3-5-3 for more information on associating axes.

For more information on associating a drive with an axis, refer to section 
3-5-3.

6. Click OK.

3-5-3 Associating an axis with a drive
An axis in CX-Motion Pro represents only the functional characteristics of a 
motion axis. To make the axis in CX-Motion Pro represent a complete motion 
axis, it must be linked to a drive that is connected to a unit. This is called 
associating.

Associate axis To associate an axis, do the following:
1. In the Solution Explorer, right-click the axis that you want to associate 

with a drive.
2. Select Assign Physical Device.
3. In the Axis Device Selection window, select a drive in the Device list to 

associate with the axis.

Note: The axis type corresponds to the BASIC command ATYPE.

Note: You cannot associate a virtual axis with a drive. Thus, if the Axis Type is 
Virtual, the Device list is disabled.

Note: If an axis in CX-Motion Pro is not associated with a drive, CX-Motion Pro 
generates an error when the device or the solution is built.
This does not hold for a virtual axis, because a virtual axis cannot be 
associated with a drive.

Note: The list of drives in the Device list is limited to drives that can support the 
axis type selected in the Axis Type list. Also, drives that are already 
associated to another axis are not in the list.

Note: If you change the selected axis type in the Axis Type list, the selected 
drive in the Device list is cleared.
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Axis Device Selection window

4. Click OK.

3-5-4 Using an axis
Before you use an axis, you must configure it. To configure it properly, it is 
useful to monitor, and test the axis. The Axis Configuration window groups 
together these actions. To show the Axis Configuration window, right-click an 
axis in the Solution Explorer and select Configure...

3-5-4-1 Configuring an axis
The configuration of an axis is determined by the values of the axis 
parameters and the drive mappings of the associated drive. The 
Configuration tab of the Axis Configuration window shows the real-time 
values of commonly used axis parameters if the device is online. If the device 
is offline, you can change the value of the axis parameters and add the code 
to initialise them in the SHELL program.

Axis Configuration window, Configuration tab

Note: If you associate a drive with an axis, CX-Motion Pro assigns an axis number to 
the axis. The axis number is determined by the drive address. Because drive 
addresses must be unique, the axis numbers are also unique, except in the 
following case: If a servo and an inverter have the same last digit in their 
address (for example, 41 hex 21 hex), the inverter will not be able to be 
associated to an axis, as CX-Motion Pro would assign the same axis number 
to both associated axes which would result in a conflict. To use the inverter as 
an axis in this scenario, its address would need to be changed so there was no 
conflict with any other inverters or drives.
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The table below lists the tabs on the Configuration tab and the axis 
parameters and information they show.

The Scaling/Units wizard calculates the axis parameters UNITS, REP_DIST
and REP_OPTION and the gear ratio numerator and denominator of the drive. 
To open the wizard, click Wizard... on the Scaling Units tab.

Tab Axis parameters/information

General
• ATYPE
• The associated drive information

Scaling Units
• UNITS, REP_DIST, REP_OPTION
• The gear ratio numerator and denominator of the associated drive
• Scaling/Units wizard (see below)
• Encoder numerator and denominator (flexible axis only)
• ENCODER_BITS and ENCODER_CONTROL (EnDat and SSI flexible 

axes only)

Tuning P_GAIN, I_GAIN, D_GAIN, OV_GAIN, VFF_GAIN

Dynamics1

1. The values on this tab are not the current axis parameter values. They are 
default values, which can be added to the SHELL program with the Add 
Axis To Shell button to initialise the axis parameters. The values on this 
tab can only be changed when the device is offline.

SPEED, ACCEL, DECEL, CREEP

Limits FE_LIMIT, RS_LIMIT, FS_LIMIT, FASTDEC

IO Mapping
• FWD_IN, REV_IN, DATUM_IN
• The drive mappings of the associated drive
• Intelligent assignment, which automatically sets the drive mappings and 

restricts the possible drive mapping options. To set the drive mappings 
manually, clear the Enable Intelligent Assignment check box. 
Intelligent assignment is automatically cleared if the axis is transferred to 
the online device and the values of the drive mappings are not possible 
according to the rules of the firmware of the online device.

Error 
Handling

ERRORMASK
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Scaling/Units Wizard window

To calculate the axis parameters and the drive ratio, select a value in the 
Encoder bits field, type a value in the fields Distance (user units), R1, R2, 
REP_DIST, select a repeat distance option with the option buttons and click 
Calculate. To do a new calculation, click Reset.

To copy the results to the Scaling Units tab and close the Scaling/Units 
Wizard window, click Accept.
The table below lists the actions that CX-Motion Pro supports to configure the 
axis. The second column in the table lists the corresponding buttons on the 
Axis Configuration window.

3-5-4-2 Monitoring an axis
The Monitoring tab of the Axis Configuration window gives feedback about 
the axis status when the device is online.

Note: If the calculated values are invalid, they show with a red background.

Action Button

Generate code for the axis parameters and 
add it to the SHELL program1

1. See also section 3-4-5.

Add Axis To Shell

Generate code for the drive parameters 
and add it to the SHELL program

Add Drive Parameters To Shell

Execute CX-Drive to tune the drive Launch CX-Drive on the Tuning 
tab
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Axis Configuration window, Monitoring tab

When an axis status bit is on, the corresponding square is red. When an axis 
status bit is off, the corresponding square is gray.

3-5-4-3 Testing an axis
On the Test Run tab of the Axis Configuration window, you can test an axis 
to check if it is properly connected and configured. To do this, the device must 
be online, and the axis must be associated to a drive.

Axis Configuration window, Test Run tab

A test run is a simple move at a given speed with a given acceleration and 
deceleration. You can set the distance argument of the BASIC command 
MOVE and the SPEED, ACCEL and DECEL parameters. Also, you can 
enable the SERVO, AXIS_ENABLE and WDOG parameters for the test run 
with the respective On or Enable buttons.
When these parameters are set, you can click Run to execute the test run. To 
stop the test run, you can click the Abort button.
The Movement, Axis Status (AXISSTATUS) and Status (DRIVE_STATUS)
groups on the Test Run tab give feedback about the movement of the axis, 
the axis status and the drive status respectively when the test run is executed.
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3-5-5 Finding an axis
If the solution contains many axes, it can be difficult to find a specific axis in 
the Solution Explorer. Therefore, CX-Motion Pro has search functionality to 
find an axis by its name.

Find axis To find an axis in the solution, do the following:
1. On the Edit menu, select Find and Replace, and then Find Axis.
2. In the Find Axis window, type the name or a part of the name of the axis 

you want to find in the Axis Name field.

Find Axis window

3. If you want to search for an axis by its whole name, select the Match 
whole word check box.

4. If you want to make the search case-sensitive, select the Match case
check box.

5. Click Find Next.
If the axis is found, it is selected in the Solution Explorer.

3-5-6 Axis Offset
Although the TJ2-MC64 can support up to 64 axes, limitations of addresses 
available for drives/inverters mean that axis offsets are needed in order to 
utilise all of the available axes. 
 
Axis offset is applied per master unit. The offset is applied to the axis number 
of each axis applied to a slave under that master. 
 
For example, with no axis offset applied, the axis for the servo at address 
16#41 is set to axis 0.

With the axis offset set to 16, the axis for the same servo is moved to axis 16

3-5-6-1 Applying axis offset
To apply an axis offset, supported controller and unit(s) need to be used.
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Only the TJ2-MC64 supports axis offset, when using the Flex (FL02), 
MECHATROLINK-II (ML04 and ML16) and EtherCAT (ECT04, ECT16 and 
ECT64) units.
Once the relevant controller and unit are in the solution tree, right-click the unit 
and select “Configure” from the menu.

Select the required offset from the list, and select OK. This will automatically 
reassign the addresses of any axes assigned to any drives/inverters 
connected to this unit.

Axis offset is set to 0 by default, and each unit can have a different axis offset, 
as long as it wouldn’t cause a clash of axis addresses.
The axis offset is not applied to the controller’s axis (rather than the solution’s 
one) until it is transferred to the controller using the synchronisation dialog. 
This is always done when using the basic layout of the synchronisation dialog, 
but needs to be select in the advanced layout. It can be found under 
“Configuration Data” in the advanced layout.

3-6 Units
A device can have several connected units. These units perform specific 
tasks: they control axes, or they control the communication with other 
networks.
These units can be stand-alone units, such as in the modular Trajexia system, 
or they can be embedded in the device, for example in the CJ1W-MCH72 and 
CJ1W-MC472 devices, which are single units with integrated 
MECHATROLINK-II functionality and flexible axis functionality.
Units in CX-Motion Pro are the representation of stand-alone units or 
embedded units in a device. CX-Motion Pro supports the following units for the 
TJ1-MC04, TJ1-MC16 and the TJ2-MC64 motion devices:

Unit Full name Description

CORT TJ1-CORT CANopen Master 
Unit

Interface with CANopen network

DRT TJ1-DRT DeviceNet Slave Unit Interface with DeviceNet network

FL TJ1-FL02 Flexible Axis Unit Master for 2 analogue drives

ECT04 TJ2-ECT04 EtherCAT Master 
Unit

EtherCAT Master for 4 drives (TJ2-
MC64 only)
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CX-Motion Pro supports the following embedded units for the MCH72 motion 
device:

3-6-1 Adding a unit
To add a unit to a motion device, do the following:

• In the Multi-view Explorer, expand the Configuration section.
• Right-click on Units, and select Add | unit-to-add.

You can add up to seven units in any combination within the rules listed 
in the following table:

3-6-2 DRT unit and PRT unit
The DRT unit and the PRT unit are slave units that exchange data between 
the device and other networks (the DeviceNet and the PROFIBUS networks 
respectively). To enable this data exchange, the device has two reserved 
areas of VR memory: 

• data input from the slave unit
• data output to the slave unit

ECT16 TJ2-ECT16 EtherCAT Master 
Unit

EtherCAT Master for 16 drives (TJ2-
MC64 only)

ECT64 TJ2-ECT64 EtherCAT Master 
Unit

EtherCAT Master for 64 drives (TJ2-
MC64 only)

ML04 TJ1-ML04 MECHATROLINK-II 
Master Unit

MECHATROLINK-II Master for 4 
drives

ML16 TJ1-ML16 MECHATROLINK-II 
Master Unit

MECHATROLINK-II Master for 16 
drives

PRT TJ1-PRT PROFIBUS-DP Slave 
Unit

Enables connection to a PROFIBUS 
network

Unit Functionality Description

FL Flexible axis functionality Controller for 1 flexible axis

ML MECHATROLINK-II 
functionality

MECHATROLINK-II controller for 31 
axes

Unit Full name Description

Note: EtherCAT and MECHATROLINK-II cannot be used in the same system. TJ2-
MC64s can support one or the other, but not both at the same time.

MC04 MC16 MC64

CORT 1 1 1

PRT or DRT 1 1 1

ECT04 1

ECT16 1

ECT64 1

FL Up to 3 Up to 7 Up to 7

ML04 Up to 4 Up to 4 Up to 4

ML16 Up to 4 Up to 4 Up to 4
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These VR memory areas must be set before the data can be exchanged. This 
is called the configuration of the DRT unit or the PRT unit.

Configure unit To configure the DRT unit or the PRT unit, do the following:
1. In the Solution Explorer, right-click the DRT unit or the PRT unit that you 

want to configure.
2. Select Configure.
3. In the DRT Configuration window or the PRT Configuration window, 

enter the memory start address and the memory size for the VR input 
memory area and the VR output memory area in the text fields.

PRT Configuration window

4. Click OK.
When the device is built, CX-Motion Pro adds code to the 'OMRON Auto 
Generated - Units section of the SHELL program to detect and configure the 
unit.

3-6-3 CORT unit
The CORT unit can be added to a motion device, but it has no functionality in 
CX-Motion Pro. The CORT unit in a device can be supported with the BASIC 
command CAN_CORT.

3-6-4 FL unit
An FL unit can control 2 analogue drives. These drives are called A and B. 
When an FL unit is added to a motion device, the 2 drives A and B are 
available to associate with a flexible axis (refer to section 3-5-3).

3-6-5 MECHATROLINK-II
MECHATROLINK-II is a motion network. It consists of a master unit and a 
number of slaves in serial connection to the master unit. A slave is an I/O or a 
drive. A drive is a servo or an inverter.
CX-Motion Pro supports 3 MECHATROLINK-II Master Units: ML04, ML16 and 
embedded ML. You can add slaves to these ML units.

Add drive To add a drive to an ML unit, do the following:
1. In the Solution Explorer, right-click the ML unit to which you want to add 

a drive.
2. Select Add Servo or Add Inverter.
3. In the Drive Selection window, select the family, model and firmware 

version for the drive from the respective lists.
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Drive Selection window

4. In the Address list, select the MECHATROLINK-II address for the drive.
5. Click OK.

Add I/O To add an I/O to an ML unit, do the following:
1. In the Solution Explorer, right-click the ML unit to which you want to add 

an I/O.
2. Select Add I/O or Vision.
3. In the Mechatrolink I/O Device Selection window, select an I/O type 

from the I/O Device Type list.

Mechatrolink I/O Device Selection window

4. In the Address list, select the MECHATROLINK-II address for the I/O.
5. Click OK.

Reset network You can reset the MECHATROLINK-II network of an ML unit. This can be 
necessary when there is a communication problem. Resetting the network is 
done with a network initialisation, when the slaves in a MECHATROLINK-II 
network are detected and connected.
To reset the MECHATROLINK-II network, do the following:

1. In the Solution Explorer, right-click the ML unit.
2. Select Initialise MECHATROLINK-II Network.

3-6-6 EtherCAT
EtherCAT is a motion network. It consists of a master unit and a number of 
slaves in serial connection to the master unit. 

• A slave is an I/O or a drive. 
• A drive is a servo.

CX-Motion Pro supports three EtherCAT units: ECT04, ECT16 and ECT64. 
You can add slaves to these ECT units.

Add drive To add a drive to an ECT unit, do the following:

Note: To reset the MECHATROLINK-II network, CX-Motion Pro sends the BASIC 
command MECHATROLINK(unit-number,0) to the device.

Note: The address ranges for ML-II inverters, IO and servos are controller 
dependant. Please check the user manual for the relevant controller for more 
information.
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1. In the Solution Explorer, right-click the ECT unit to which you want to add 
a drive.

2. Select Add Servo.
3. In the Drive Selection window, select the family, model and firmware 

version for the drive from the respective lists.

Drive Selection window

4. In the Address list, select the EtherCAT address for the drive.

5. Click OK.

Add I/O To add an I/O to an ECT unit, do the following:
1. In the Solution Explorer, right-click the ECT unit to which you want to add 

an I/O.
2. Select Add I/O or Vision.
3. In the EtherCAT I/O Device Selection window, select an I/O type from the 

I/O Device Type list.

EtherCAT I/O Device Selection window

4. In the Address list, select the EtherCAT address for the I/O.

5. Click OK.

Reset network You can reset the EtherCAT network of an ECT unit. This can be necessary 
when there is a communication problem. Resetting the network is done with a 
network initialisation, when the slaves in an EtherCAT network are detected 
and connected.
To reset the EtherCAT network, do the following:

1. In the Solution Explorer, right-click the ECT unit.

Note: The addresses for servos range from 1 to 64. The addresses for inverters 
range from 1 to 10,000. Not all of the  inverters supports this range, check 
the user manual for the inverter to confirm the range.
To use 64 axes, the TJ2-MC64 needs to be running with the servo period 
set to 2ms.

Note: The addresses for IO range from 0 to 65,535. Not all of the  IO supports 
this range, check the user manual for the IO to confirm the range.
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2. Select Initialise EtherCAT Network.

3-6-7 Configuring a drive
The Drive Configuration window groups together the following drive 
configuration operations and information: 

• Change the drive parameters
• Transfer the drive parameters to and from the drive
• Monitor the drive
• Reset the drive
• Generate code for the SHELL program

To open the Drive Configuration window, right-click a drive in the Solution 
Explorer and select Configure...

3-6-7-1 Changing the drive parameters
The drive configuration consists of a set of drive parameters and their values. 
You can change the drive parameters in the parameter editor, which is on the 
Parameter Editor tab on the Configuration tab in the Drive Configuration
window.

Drive Configuration window, Parameter Editor tab

The parameter editor has the following elements:
• A text field, in the upper half, which shows the description of the selected 

parameter
• A filter row, marked with , where you can set a filter on the parameter list
• The parameter list, in the lower half, which shows all parameters grouped 

together in categories
To change a parameter, enter a new value in the Value column of the selected 
parameter in the parameter list. If the value of the parameter is different from 
the default value, the circle in the first column shows in red .

Note: To reset the EtherCAT network, CX-Motion Pro sends the BASIC command 
ETHERCAT(0,unit-number) to the device.
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3-6-7-2 Transferring the parameters
To transfer the drive parameters from CX-Motion Pro to the drive or vice versa, 
the device must be online. The table below lists the transfer operations that 
CX-Motion Pro supports for drive parameters. The third column in the table 
lists the steps to do the transfer operation.

3-6-7-3 Monitoring the drive
The Monitoring tab shows the real-time monitoring information of the drive 
when the device is online.
The Alarms tab shows the current alarm of the drive, if it has one. To clear the 
current alarm, click Reset.
Previous alarms show in the lists in the History and Trace tabs. To clear the 
previous alarms, click Clear History/Trace.

Drive Configuration window, Alarms tab

The Servo Monitor tab shows the drive status and the I/O status. When an 
axis status bit or I/O bit is on, the corresponding square is red. When an axis 
status bit or I/O bit is off, the corresponding square is gray.

Parameters Transfer direction Steps

Selected From CX-Motion Pro to the 
drive

Change the value1

1. The changed value is transferred to the drive real-time.

All From CX-Motion Pro to the 
drive

Click Transfer All To Device

Selected From the drive to CX-Motion 
Pro

Click Transfer From Device

All From the drive to CX-Motion 
Pro

Click Transfer All From 
Device
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Drive Configuration window, Servo Monitor tab

3-6-7-4 Resetting the drive
CX-Motion Pro supports 2 drive resets, which are listed in the table below. The 
second column in the table lists the corresponding buttons on the Drive Reset
tab. 

3-6-7-5 Generating code for the drive parameters
You can add code to the SHELL program to initialise the drive parameters that 
have a non-default value, that is, drive parameters that are indicated with a red 
circle  in the parameter list in the parameter editor. To add code for these 
drive parameters, click the Add Drive Parameters To Shell button in the 
Drive Configuration window.
The code for the initialisation of the drive parameter is added under 'Drive 
Parameters in the ' Start Standard Section outline of the SHELL program.

Note: If the axis that is associated with the drive has an error, the Servo Monitor tab 
opens when the user opens the Drive Configuration window.

Drive reset Button

Clear the alarm status of the drive Clear

Complete drive reset Reset

Note:
• CX-Motion Pro does not check if the code that you want to generate is 

already in the SHELL program. If you add code for the same drive 
parameters twice, the same drive parameter initialisations are in the 
SHELL code twice.

• You can change the added code.
• You can only generate code for the drive parameters when the device is 

offline.
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3-7 Data traces
A data trace is a set of real-time values that are obtained by monitoring a 
parameter during a period of time and logging the parameter values. A 
parameter can be an axis parameters, a digital input or a digital output of a 
device.
CX-Motion Pro can show the data trace values as a graph. This graph is useful 
to represent the motion in a device, and can help when you develop or debug 
a motion application. Also, CX-Motion Pro can save the values in a file.
A data trace in CX-Motion Pro consists of the following items:

• Four parameters that are monitored
• A sample period, which is the period of time during which the parameter 

values are logged
• A sample rate, which is the interval between logging 2 consecutive 

parameter values
CX-Motion Pro can only log the data trace values when the device is online. 
For more information on online devices, refer to section 4-4.

3-7-1 Adding a data trace

Add data trace To add a data trace to a motion device, do the following:
1. In the Solution Explorer, right-click Data Traces under the motion 

device.
2. Select Add Data Trace.

A new data trace is added under Data Traces in the Solution Explorer. 
By default, the 4 parameters are digital inputs 0 to 3.

3. Right-click the data trace in the Solution Explorer, and select Open.
The data trace window opens. This window has a toolbar, a graph view 
and a parameter list.

Data trace window

Note: CX-Motion Pro uses the Oscilloscope memory area to store the data trace 
values. You must make sure that the Oscilloscope memory area is large 
enough to store all values. The number of values is determined by the formula 
sample-period ÷ sample-rate × 4 (because a data trace monitors 4 
parameters). For example, if the sample period is 10 s, and the sample rate is 
2 ms (0.002 s), the size of the Oscilloscope memory area must be at least 10 ÷ 
0.002 × 4 = 20,000. If it is less, CX-Motion Pro shows an error message.
Refer to section 3-2-3-5 for information on changing the size of the 
Oscilloscope memory area.
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4. In the parameters list, click the ellipsis button in the Change column of the 
parameter that you want to change.

5. In the Parameter Selection window, select an axis or a set of digital 
inputs or outputs in the Group list.

Parameter Selection window

6. In the Parameters list, select an axis parameter or a digital input or output.
7. Click OK.
8. Repeat the 4 previous steps for the other parameters that you want to 

change.
9. In the Properties window, set the sample period of the data trace with the 

SamplePeriod property.

Data trace properties

10.Set the sample rate with the SampleRate property.

3-7-2 Logging the data trace values
The data trace starts logging the values when it is triggered to start. There are 
2 methods to trigger a data trace to start logging the values:

• Manual
• Programmable

A programmable trigger is equivalent to the BASIC command TRIGGER. If 
you want to use a programmable trigger, you must include the TRIGGER
command in a program, and set the Trigger property to Programmable.

Manual trigger To trigger the data trace to start logging values manually, do the following:



Data traces SECTION 3 Solutions

68

1. Set the value of the Trigger property to Manual.
2. Right-click the data trace in the Solution Explorer.
3. Select Start Logging.

The data trace stops logging the values when the sample period has elapsed. 
When you want the data trace to stop logging before the sample period has 
elapsed, you can right-click the data trace in the Solution Explorer and select 
Stop Logging.

3-7-3 Viewing the graph
When the data trace logs the values, CX-Motion Pro can show a graph of 
these values. The graph shows in the graph view of the data trace window.
The data trace window has many layout features to change the layout of the 
graph view. The table below lists the layout features. The second column lists 
the corresponding steps.

Feature Steps

Show the graph as a standard graph 
(that is, not a scaled graph) Click  on the toolbar

Show the graph as a scaled graph, in 
which the values on the Y axis are 
scaled to a selected axis

Click  on the toolbar

Show or hide the graph for a 
parameter

Select or clear the check box in the 
Display column of the parameter in 
the parameter list

Move the graph for a parameter up or 
down along the Y axis (only for 
standard graphs)

Change the value in the Offset 
column of the parameter in the 
parameter list

Show an axis for the Y axis scale 
(only for scaled graphs)

Select the checkbox in the Y Axis 
column in the parameter list

Change the minimum and maximum 
values for a scaled Y axis (only for 
scaled graphs)

Change the values in the Y Axis Min 
and Y Axis Max columns in the 
parameter list

Select or clear the automatic 
adjustment of the X axis scale as the 
graphs are drawn in the graph view

Click  on the toolbar

Show or hide the markers that 
indicate points on the graph Click :on the toolbar

Show or hide the grid lines
Click  on the toolbar

Show or hide the graph cursor
Click  on the toolbar

Change the X axis scale
Click  on the toolbar and select a 
value for the X axis scale (which can 
be the time or one of the 4 
parameters)
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3-7-3-1 Load data
The graph that a data trace window shows is drawn from the data trace 
values. However, you can also load values from 2 other sources in the data 
trace window to draw a graph:

• From a CSV file that contains previously saved data trace values

To load data trace values from a CSV file, click the  button on the 
toolbar and select a CSV file.

• From a Table memory area
To load values from a Table memory area, click the  button on the 
toolbar. The parameter list in the data trace window is replaced by a Table 
list, in which you can enter the start address and the end address of the 
Table memory area.

Data trace window with Table list

Zoom in
Click  on the toolbar, select 
Zoom In and drag the mouse pointer 
over the area in the graph view that 
you want to zoom in to

Zoom out
Click  on the toolbar and select 
Zoom Out to zoom out one step, or 
select Zoom Reset to return to the 
default zoom setting

Select the pan mode, in which only a 
portion of the graphs shows, which 
can be dragged across the graph view

Click  on the toolbar and select 
Pan On 

Clear the pan mode, so that the graph 
view shows the entire graphs Click  on the toolbar and select 

Pan Off

Feature Steps

Note: To return to the standard view of a data trace graph, click the  button 
on the toolbar. The Table list is replaced by the parameter list.
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3-7-4 Saving the data trace values
You can save the data trace values in a CSV file, with the  button on the 
data trace window toolbar.

3-8 General operations in the Solution Explorer
The Solution Explorer shows the items in the solution in a hierarchical way. 
The root item is Devices. Under Devices, the devices in the solution are 
listed.
Some items in the Solution Explorer are fixed. They cannot be added, 
changed or deleted. Some items are variable. They can be added, changed 
and deleted. The table below lists the variable items in the Solution Explorer
and the parent items under which they show.

CX-Motion Pro supports the following general operations on variable items in 
the Solution Explorer:

• Change order
• Delete
• Rename
• Cut, copy, paste
• Copy with drag-and-drop

Change order You can change the order of solution items as follows: you can move a 
solution item in the Solution Explorer in front of another solution item.
To move solution-item-1 in front of solution-item-2, do the following:

1. In the Solution Explorer, select solution-item-1.
2. Drag solution-item-1 on solution-item-2 in the Solution Explorer.

To move solution-item to the back of the order, do the following:
1. In the Solution Explorer, select solution-item-1.
2. Drag solution-item-1 on its parent item in the Solution Explorer.

The order of all solution items except units in the solution explorer does not 
matter. You can change the order according to your preferences, but it does 
not have an influence on the solution.
The order of units is determined by their unit numbers. When you change the 
order of units, their unit numbers are also changed.

Note: A data trace is part of the solution, and thus it is saved when the solution is 
saved. However, the data trace values are not saved in the solution file. You 
must save the values separately in a CSV file.

Parent item Variable item

Devices Device

CAM Tables CAM table

Programs Program

Axes Axis

Units Unit

Data Traces Data trace

ML unit MECHATROLINK-II Master

ECT unit EtherCAT Master



General operations in the Solution Explorer SECTION 3 Solutions

71

The order of axes is synchronised with the order of the addresses of the 
associated drives and the unit number of the units to which the drives are 
connected. If axes are associated with drives, you cannot change their order. 
And if you change the order of drives, the association with the axes is lost. For 
more information on associating an axis with a drive, refer to section 3-5-3.

Delete To delete a solution item from the solution, do the following:
1. In the Solution Explorer, select the solution item.
2. On the Edit menu, select Delete.

Rename Some solution items have a name. CX-Motion Pro assigns the name 
automatically when you add this solution item to the solution. This name is 
item-n, where n is a sequence number. You can change the name of a 
solution item. This makes it easy to identify and find a solution item in the 
solution.
To change the name of a solution item, do the following:

1. Right-click the solution item in the Solution Explorer.
2. Select Rename.
3. Type the new name for the solution item.
4. Press ENTER.

Cut, copy, paste CX-Motion Pro supports the clipboard operations cut, copy and paste for 
solution items.
To cut or copy a solution item, do the following:

1. Select the solution item in the Solution Explorer that you want to cut or 
copy.

2. On the Edit menu, select Cut or Copy.
To paste a solution item, do the following:

1. Select the solution item in the Solution Explorer under which you want to 
insert the contents of the clipboard.

2. On the Edit menu, select Paste.

Copy with drag-and-drop With a drag-and-drop operation, you can copy a solution item in the Solution 
Explorer without using the clipboard.

Note: The following rules apply for the name of a solution item:
• A valid name consists of letters, digits and underscores. Other characters 

are not allowed.
• The first character cannot be a number.

Note: CX-Motion Pro checks If the contents of the clipboard can be pasted under the 
selected solution item. If it cannot be pasted, the Paste menu item is disabled.
For example, if the clipboard contains a device, and the selected solution item 
in the Solution Explorer is CAM Tables, the Paste menu item is disabled, 
because a device cannot be added under CAM Tables.

Note: When you copy and paste a MECHATROLINK-II slave, CX-Motion Pro opens 
the Drive Selection window (for drives) or the Mechatrolink I/O Device 
Selection window (for I/Os), where you must select a new address for the 
copied slave. If you do not select a new address, CX-Motion Pro cannot paste 
the slave, because all slaves must have a different address.

Note: When you copy and paste an axis that is associated to a drive, the copied axis 
does not have a drive association, because 2 axes cannot be associated with 
the same drive.
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To copy a solution item, do the following:
1. Select the solution item in the Solution Explorer that you want to copy.
2. Press and hold down the CTRL key.
3. Drag the solution item to a solution item under which you want to insert the 

copy.
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SECTION 4
Work online

4-1 Introduction
In CX-Motion Pro, you can design and develop motion applications for one or 
more devices. If these devices are connected to the computer, CX-Motion Pro 
can communicate real-time with them. It can transfer programs and data from 
and to the device, and it can execute programs in the device.

4-2 Hardware connection
A device may support several connection methods, such as Ethernet, serial or 
USB. CX-Motion Pro supports all these connection methods for the supported 
devices.
Refer to the manual of the connected device for more information on the 
following topics:

• The supported connection methods
• The network settings of your computer if you use an Ethernet connection

4-3 Online concepts
When CX-Motion Pro communicates real-time with a connected device, the 
device is called online. The device in the solution in CX-Motion Pro is the 
interface via which CX-Motion Pro communicates with the online device. A 
device that is not online is called offline.
When a device is online, CX-Motion Pro can make the contents of the device 
in the solution match with the contents of the online device. This is called 
synchronisation. Synchronisation is discussed in section 4-5.
When a device is online, you can transfer the motion application you 
developed to the device, and you can view and edit the values of variables 
and memory areas in the device (refer to section 4-6). Also, you can execute 
and debug the programs in the device. For information on how to debug a 
program, refer to section 5.
CX-Motion Pro can also do the following actions on an online device:

• Perform a motion stop on all motion axes
• Lock the device
• View the communication channels
• Make a back-up of the memory in the device
• Update the firmware of the device
• Compare programs on the online device and in the solution
• Reset the device
• Debug a program
• Send commands with the Terminal window
• Monitor the communication channels

These actions are described in sections 4-7 and 5.

4-4 Going online
Go online To go online to a device, do the following:

1. Make sure that the device is connected to the computer on which CX-
Motion Pro runs.
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2. Set the communication settings for the device (see section 3-2-3).
3. Select the device in the Solution Explorer.
4. On the Online menu, select Work Online/Offline.

CX-Motion Pro builds the device and synchronises it with the connected 
device (see section 4-5). When the build and the synchronisation are 
successful, the device is online.
When a device is online, an online icon  shows on the device in the 
Solution Explorer. Also, the status bar indicates that the selected device is 
online.
To go offline, select the online device in the Solution Explorer and select Work 
Online/Offline on the Online menu.

4-5 Synchronisation
Before CX-Motion Pro synchronises a device, it builds the device. If there are 
build errors, CX-Motion Pro asks for your confirmation before it continues, 
because build errors can lead to unexpected behaviour of the device.

Confirm build errors before synchronisation

You usually want to correct the build errors before you synchronise the device.
CX-Motion Pro supports synchronisation in 2 directions:

• To device
This synchronisation transfers the device in the solution to the online 
device.

• From device
This synchronisation transfers the online device to the device in the 
solution.

CX-Motion Pro supports 2 types of synchronisation: simple and advanced.

4-5-1 Simple synchronisation
The simple synchronisation transfers the following items:

• Programs
• Axes
• Units

You can also synchronise the following items, if you select the corresponding 
check boxes in the simple Synchronise with Device window:

• Axis parameters
• Table memory
• VR memory
• Configuration of drive(s)
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Simple Synchronise with Device window

The simple synchronisation supports the Fast Program Transfer mode. In this 
mode, all programs are deleted from the device in the solution or in the online 
device before all programs are transferred. To synchronise programs in the 
Fast Program Transfer mode, select the Fast Program Transfer Mode check 
box.
Click Transfer To Device to transfer from the device in the solution to the 
online device. Click Transfer From Device to transfer from the online device 
to the device in the solution. Click Connect Only to keep the device online 
without synchronising items.

4-5-2 Advanced synchronisation
The advanced synchronisation offers more flexibility and features than the 
simple synchronisation.

• The advanced synchronisation gives detailed feedback on the matches 
and differences between the device in the solution and the online device.

• You can specify which items to synchronise on a detailed level.
The advanced synchronisation is done from the advanced Synchronise with 
Device window. To show this window, click Advanced >> in the simple 
Synchronise with Device window.

Advanced Synchronise with Device window

Note: If you transfer the axes from an online device to the device in the solution, all 
axes are transferred, even the axes that are not used. Axes that are not used 
are virtual axes, and CX-Motion Pro cannot distinguish between unused virtual 
axes and used virtual axes. Therefore, also unused virtual axes are transferred 
to the device in the solution.
You can remove unused axes in the device in the solution when the device is 
offline.
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The advanced Synchronise with Device window shows a tree view of the 
device and the programs, the VR memory and the Table memory (under 
Global Data), the axes, the units and the drives (under the units to which they 
are connected). The tree view uses colours to indicate the matches and the 
differences between the device in the solution and the online device, and icons 
to indicate the synchronisation status.

Each item has a check box. Select the check box to include the item in the 
synchronisation. If you select or clear the check box of an item in the tree that 
has child items, all the check boxes of the child items are selected or cleared.
The advanced synchronisation also supports the Fast Program Transfer 
mode, in which all programs are deleted from the device in the solution or in 
the online device before all programs are transferred (applies only to Transfer 
to Device). To synchronise programs in the Fast Program Transfer mode, 
perform one of the following actions:

• Select the Fast Program Transfer Mode check box.
• Select the Programs check box in the tree view, and select the Delete all 

programs on target before transfer check box.

Click Transfer To Device to transfer from the device in the solution to the 
online device. Click Transfer From Device to transfer from the online device 
to the device in the solution. Click Connect Only to keep the device online 
without synchronising items.

Colour Label Description

Black Synchronised The items in the device match

Red Differences The items in the device are different

Green In Project The item exists in the device in the solution, but not 
in the online device

Blue On Device The item exists in the online device, but not in the 
device in the solution

Note: The Solution Explorer uses the colours black, red and green to indicate the 
matches and differences of the items under a device in the solution and the 
online device.

Note: If a program in the device in the solution and the corresponding program on 
the online device are different, you can compare the programs with a viewer 
that shows the differences. Refer to section 4-7-6.

Icon Synchronisation 
status

Description

Synchronised The items are synchronised

Not checked CX-Motion Pro has not checked if the items 
are synchronised

Warning The item exists in the online device, but not 
in the device in the solution, or vice versa

Error The items are different

Note: The Fast Program Transfer Mode check box is enabled when the Programs 
check box is selected in the tree view and the Delete all programs on target 
before transfer check box is selected. In all other situations, the Fast 
Program Transfer Mode check box is disabled.

Note: If a program is running, you cannot transfer it to the online device.
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4-5-3 Transferring a program to the device
CX-Motion Pro offers a quick way to transfer a program to the device when the 
device is online. This is useful when you debug a program: you can change 
some code in the program, and then quickly transfer it to the device without 
doing a full synchronisation.
To transfer a program to the device, select Transfer Program To Device on 
the Online menu.

4-6 Monitoring
CX-Motion Pro supports the monitoring mode for online devices. When the 
monitoring mode is on, CX-Motion Pro monitors the values of variables and 
memory areas in the online device. When the monitoring mode is off, CX-
Motion Pro shows only the values of variables and memory areas that are set 
in the solution. They can be different from the values in the online device, if the 
device is not synchronised.
On the other hand, if a device is online and the monitoring mode is on, CX-
Motion Pro does an automatic background synchronisation: the following 
items are transferred from the online device to the device in the solution:

• Table memory
• CAM tables
• VR memory
• Axis parameters

An important limitation of the automatic background synchronisation is the 
following: the items are only transferred from the online device to the device in 
the solution if they are visible in CX-Motion Pro. For example, if a device is 
online, the monitoring mode is on, and the VR Memory window of the device 
is open and has the focus, only the VR variables that are visible in the VR 
Memory window are transferred from the online device to the device in the 
solution. When you scroll the VR Memory window up or down, another set of 
VR variables is visible and then these variables are automatically 
synchronised in the background.1

The automatic background synchronisation also works in the other direction, 
from the device in the solution to the online device. When you change a value 
in the Table memory, a CAM table, the VR memory or an axis parameter in the 
device in the solution, this value is automatically transferred to the online 
device.

Note: Sometimes you cannot transfer a program to an online device when another 
program is running. This depends on the device. If you cannot transfer a 
program because another program is running, CX-Motion Pro shows a 
message.

Note: The menu item Transfer Program To Device is disabled when the selected 
program is not changed.

1. The reason for this implementation is efficiency. Because synchronisation of 
large amounts of data (such as the complete Table memory) is slow, only the 
visible part is transferred.

Note: When the user is entering text in an edit field, CX-Motion Pro does not show 
the new values of variables that are updated by the background 
synchronisation.
When the user finishes or cancels entering text in an edit field, the updated 
values of the variables are shown in CX-Motion Pro.
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To set the monitoring mode on or off, select Monitor on the Online menu

4-7 Other online actions

4-7-1 Stopping motion
CX-Motion Pro has a motion stop function. This function stops all motion on all 
axes connected to a device, and stops all programs that are running in the 
device.

Stop motion To stop all motion on a device, do the following:
1. In the Solution Explorer, select the corresponding device.
2. On the Online menu, select Stop Motion.

4-7-2 Locking
CX-Motion Pro can lock a device. If a device is locked, you cannot go online. 
This is useful when you want to disable access to the device for unauthorised 
users.

Lock device To lock a device, do the following:
1. In the Solution Explorer, select the device.
2. On the Online menu, select Lock Device.
3. Click Yes in the Lock Device dialog box.
4. In the Controller Lock Code window, type a lock code in the text field.

Controller Lock Code window

5. Click OK.
6. Enter the lock code again in the Controller Lock Code window to confirm 

the lock code.
7. Click OK.

When you lock the device, it goes offline.
If you want to go online to a locked device, you must unlock it. Enter the lock 
code in the Controller Unlock Code window and click OK.

Controller Unlock Code window

Note: The following values are read-only and cannot be changed when the device is 
online:

• Constants
• The global name of a VR variable

Note: The motion stop function in CX-Motion Pro is not a safety function and it is not 
an emergency stop. When you must perform an emergency stop on a device, 
use the physical emergency stop on the device.

Note: If you forget the lock code, you cannot unlock the device. You must send it to 
the distributor or the manufacturer to remove the lock.
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4-7-3 Channels
A device has a number of communication channels. A communication channel 
is a direct communication connection to the device.
Channel 0 is used for the Terminal window (see section 5-5). Channels 5, 6 
and 7 are user communication channels. You can use these channels to 
communicate with programs that are running in the device. CX-Motion Pro can 
show the communication on these channels in a channel window. To open a 
channel window, select the online device in the Solution Explorer and select 
Channel #n under Channels on the View menu.

Channel #5 window

The channel window is a simple text output window that shows the 
communication. You can right-click on the channel window to copy the text to 
the clipboard or clear the contents of the window.

4-7-4 Memory back-up
Programs and data are stored in the RAM memory of a device. If the device 
also has an EPROM memory, CX-Motion Pro can copy the programs (but not 
the data) from the RAM memory to the EPROM memory and vice versa. This 
is useful because the device copies the programs in the EPROM memory to 
the RAM memory when it is switched on, to make sure that the RAM memory 
has the correct programs.

To copy the programs from the source memory of a device to the target 
memory, select the corresponding online device in the Solution Explorer, and 
select one of the following commands on the Online menu:

If you copy the programs, CX-Motion Pro performs the following actions:
• All programs in the source memory are copied to the target memory.

Note: CX-Motion Pro can only show the communication on the user channels 5,6 
and 7. It cannot send commands via these channels. To send commands via 
the user channels, you need an input device connected to the device, such as 
a keypad.

Note: Memory back-up does not apply to TJ2-MC64. This automatically backs up 
programs to Flash-ROM (no separate command required and no option to 
decide where to recover programs from).

Command Source memory Target memory

Fix Into EPROM RAM EPROM

Recover From EPROM EPROM RAM

Note: Existing programs in the target memory are overwritten.
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• The device is restarted.
• The connection between CX-Motion Pro and the online device is broken.
• The copied programs with a startup priority are automatically started at 

power up or after a software reset of the device.

4-7-5 Firmware update
CX-Motion Pro can update the firmware version of a connected device. This 
replaces the existing firmware of the device with new firmware.

Update firmware To update the firmware of a device, do the following:
1. Select the device in the Solution Explorer.
2. On the Online menu, select Download Firmware.
3. In the Load New Firmware dialog box, click Yes.
4. In the Select New Firmware File dialog box, select a firmware file and 

click OK.

The device goes online, and the firmware version of the device is updated with 
the firmware version from the selected firmware file.

4-7-6 Comparing programs
CX-Motion Pro has a viewer that shows the differences between a program in 
the device in the solution and the corresponding program on the online device: 
the Program Compare window.

Compare programs To open the Program Compare window, do the following:
1. Select the program in the Solution Explorer.
2. On the Online menu, select Program Compare.

Note: If you update the firmware version of a device, the existing firmware is 
overwritten.

Note: Before you update the firmware version of a device, make sure that you do the 
following:

• Stop the axes connected to the device.
When the firmware update is in progress, control of the axes and I/Os is 
not possible.

• Save the programs in the device.
The firmware update deletes all programs in the RAM and EPROM of the 
device.

Note: Do not close CX-Motion Pro when the firmware update is in progress. This can 
lead to unexpected results.

Note: To update the firmware of the connected device, this device must be offline. 
The device goes online automatically during the firmware update.

Note: Firmware files for TJ1-MC04, TJ1-MC16 and TJ2-MC64 devices have the 
file extension .out.
Firmware files for MCH72 and MC472 devices have the file extension 
.bin.

Note: The firmware update can take several minutes.
Note: For all but the TJ2-MC64, firmware download will only work when the servo 

period of the controller is set to 1ms. For the TJ2-MC64, any servo period can 
be used.
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Program Compare window

The Program Compare window shows the 2 programs in 2 windows that are 
tiled horizontally, where matching lines are at the same horizontal position. 
This viewer makes it very easy to see the differences between the programs 
instantly. The program in the device in the solution is on the left, the program in 
the online device is on the right.
The table below lists the background colours that the Program Compare
window uses to mark the differences.

The table below lists the toolbar buttons of the Program Compare window 
and the corresponding description.

Note: The menu item Program Compare is disabled if the program in the device in 
the solution and the program on the online device are not different. If the 
programs are not different, they do not show in red.

Note: The menu item Program Compare is also available in the shortcut menu of a 
program in the Solution Explorer, and in the shortcut menu of a program in 
the tree in the Advanced Synchronise with Device window.
Again, if the programs are not different, they do not show in red, and the 
Program Compare menu item is disabled.

Background colour Difference

Green (left window) or blue (right window) The code is present and different

Gray The code is not present

Toolbar 
button

Description

Navigate to the next difference

Navigate to the previous difference

Search for a find string in the left or the right window1

Repeat the last search
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To close the Program Compare window, click the OK button.

4-7-7 Reset
CX-Motion Pro can reset an online device. This is equivalent to the BASIC 
command EX or EX(0). The reset is a software reset of the device.
To reset an online device, select the device in the Solution Explorer, and 
select Reset Device on the Online menu.

4-7-8 Maintenance terminal
CX-Motion Pro can connect to the motion device while maintaining the 
solution in an offline state. When started in this state, CX-Motion Pro will only 
allow the user to issue terminal commands. This is particularly useful when the 
motion device is not behaving in the expected manner.

Maintenance Terminal

To open the Maintenance Terminal, from the Online menu select 
Maintenance Terminal.

1. If you want to search for text in the left (or right) window, click in the left 
(or right) window, and then click the  or the  button. The title bar of 
the Find window shows in which window the search is performed. The 
search is performed from the cursor position forward.
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SECTION 5
Debugging

5-1 Introduction
CX-Motion Pro has an integrated debugger. With the debugger, you can 
observe the behaviour of BASIC programs when they are running and find 
logical or semantic errors in the programs.

The CX-Motion Pro debugger has the following tools:
• Breakpoints
• Execution control
• Watches
• Terminal window

The debugger tools are only accessible for online devices.

5-2 Breakpoints
A breakpoint is a mark in the program code that causes the debugger to 
temporarily stop the execution of the program when it reaches the mark. When 
the execution of the program is stopped at a breakpoint, the program 
execution is said to break, and the program and the debugger are said to be in 
break mode. In break mode, the state of the program is frozen. The variables 
and I/O statuses remain in the memory, and their values can be examined. 
The program can resume execution from the break mode at any time.
A breakpoint is indicated with a dark red background colour in the code editor, 
and with a breakpoint icon in the margin bar of the code editor. A breakpoint 
can have 2 states: enabled or disabled.

The table below lists the actions that CX-Motion Pro supports for breakpoints 
in the code editor. The second column lists the corresponding commands on 
the Programs menu, under Breakpoints.

Note: The debugger functions are only available when CX-Motion Pro is online.

Icon State Description

Enabled An enabled breakpoint is an active breakpoint. It causes the 
program execution to break.

Disabled

A disabled breakpoint is inactive. The program execution 
does not break at an inactive breakpoint. However, the 
breakpoint mark is still in the program code. A disabled 
breakpoint is useful if you do not want the program 
execution to break, but you want to keep the breakpoint 
mark in the program code, to enable it later.

Action Command

Set an enabled breakpoint on the current line Toggle Breakpoint

Clear the breakpoint from the current line Toggle Breakpoint

Clear all breakpoints in the current program Delete All 
Breakpoints

Enable all breakpoints in the current program Enable All 
Breakpoints

Disable all breakpoints in the current program Disable All 
Breakpoints
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5-3 Execution control
The CX-Motion Pro debugger supports the following functions to control the 
execution of a BASIC program:

• Start execution
• Stop execution
• Break execution
• Step through the program

5-3-1 Starting execution

Start/restart execution To start the execution of a program or to restart the execution of a program in 
break mode, do the following:

1. In the Solution Explorer, select the program.
2. On the Programs menu, select Run.

The program runs until it reaches a breakpoint. After this, the program is in 
break mode. To resume the execution from the break mode, restart the 
execution.
If the program has no breakpoints, the execution stops at the end of the 
program.

5-3-2 Stopping execution
If you stop the execution of a program, you stop the debugger. This is different 
from the break mode, in which the debugger is still active and from which you 
can resume the execution.

Stop execution To stop the execution of a program, do the following:
1. In the Solution Explorer, select the program.
2. On the Programs menu, select Stop.

5-3-3 Stepping through a program
If you step through a program, you execute one line of code at a time, after 
which the program is in break mode. To execute the next line of code, step 
again.

Step through program To step through a program, do the following:
1. Open the code editor window of the program.
2. Make sure that the program is in break mode.
3. On the Programs menu, select Step.

After each step, the program is in break mode. In break mode, you can 
continue stepping, or you can restart the execution (see section 5-3-1).

Navigate to the next breakpoint in the current 
program

Next Breakpoint

Navigate to the previous breakpoint in the current 
program

Previous Breakpoint

Action Command
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5-3-4 Navigating to the execution location
If a program is running, it can be useful to know which line of the program is 
currently executed.

Navigate to current line To navigate to the line in the program that is executed, do the following:
1. Open the code editor window of the program.
2. On the Programs menu, select Goto Current Line.

The cursor in the code editor window moves to the line of code that is currently 
executed, and the line is marked with a yellow background colour.

5-4 Watches
A watch or a watched variable is a real-time view of the value of a variable in a 
program. Watches are useful to debug a program when the program does not 
behave as expected.
The Watch window lists the defined watches. For more information on the 
Watch window, refer to section 2-4-2-8.

5-4-1 Adding a watch
There are 2 ways to add a watch to the Watch window:

• Select a variable in a code editor window and drag it to the Watch window
• Select a variable in the Add Watch Item window

Drag variable To drag a variable from the code editor to the Watch window, do the following:
1. Select a variable name in the code editor.
2. Drag the selected text from the code editor to the Watch window.

Add watch To select a variable in the Add Watch Item window, do the following:
1. In the Watch window, click the Add ...

Add Watch Item window

2. In the Add Watch Item window, select a device from the Device list.
3. Select the type of watch from the Group list. Select Symbol to add a 

watch for a variable in a program. Select VR Table, Table, Constant, 
Global or IO to add a watch for the corresponding global data item.

4. Select the program that contains the watch from the Program list. This list 
is only visible when Symbol is selected in the Group list.

5. Select the index of the variable to watch in the memory area from the 
Index list. This list is only visible when VR Table, Table or IO is selected 
in the Group list.

Note: If the selected text is not a variable name, you cannot drop it in the Watch 
window.
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6. Select the I/O type of the watch (digital or analogue, input or output) from 
the IO Type list. This list is only visible when IO is selected in the Group
list.

7. Select the name of the variable to watch from the Name list. This list is 
only visible when Symbol, Constant or Global is selected in the Group
list.

8. Click OK.

5-4-2 Viewing a watch
To view the real-time value of a watch, CX-Motion Pro must be in monitoring 
mode.
CX-Motion Pro supports 2 ways to view the real-time value of a watched 
variable when a program is running:

• In the Watch window
The Value column of the Watch window shows the value of the defined 
watches.

• In the code editor
When you hover the mouse pointer over a variable in the code editor, a 
tooltip shows with the value of the variable.

View watch in the code editor

5-4-3 Changing the value of a variable
You can change the value of a variable in a running program. This is useful for 
debugging a program, because you do not have to change the program to 
have an influence on the program execution and results.

Change variable value To change the value of a variable in a running program, do the following:
1. Add a variable in the program to the Watch window (refer to section 5-4-

3).
2. Execute the program.
3. Change the value in the Value column of the Watch window. Refer to 

section 2-3-1 for information on how to edit a value in a tabular view.
The value of the variable in the running program is changed. The program 
execution continues with the new variable value.

5-4-4 Deleting a watch
To delete a watch, select the corresponding row in the Watch window and 
click Delete.

Note: The values in the lists in the Add Watch Item window are refreshed after a 
build. For example, if you add a variable to a program, the variable does not 
show in the Name list in the Add Watch Item window until the program is built 
successfully.

Note: It is also possible to change the value in the Name column of a watch in the 
Watch window. However, this does not change the name of the watched 
variable.
If you change the name of a watch in the Watch window, and this name is not 
the name of a variable in the program, the watch is invalid. An invalid watch 
shows in red in the Watch window.
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5-5 Terminal window
The Terminal window is used for direct communication with the online device. 
In the Terminal window, you can execute BASIC commands in the device. This 
is useful for debugging, because you can execute commands immediately and 
do not have to write and transfer a BASIC program.
To open the Terminal window, select a device in the Solution Explorer, and 
select Terminal Window on the View menu.

Terminal window

The Terminal window has 2 parts:
• Output area

This is the large text area that shows all commands executed in the device 
via the Terminal window (prefixed with >>), and the response from the 
device.

• Input field
This is the text field at the bottom of the Terminal window where you type 
the commands to execute in the device. The input field supports some 
useful features, which are listed in the table below. The second column 
lists the corresponding keys.

To execute a command in the device, type the command in the input field, and 
click Send or press ENTER.

Feature Keys

Show a list of commands to insert CTRL+SPACE
(See section 2-2-4-2)

View the argument information for a 
command

CTRL+SHIFT+SPACE
(See section 2-2-5-6)

Select the previous or the next command in 
the list of recent commands 

ARROR UP or ARROW DOWN

Note: If you execute commands via the Terminal window, you can change the 
synchronisation status of the online device.
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Appendix A
Shortcut keys in the code editor

A.1 Navigation

A.2 Selecting text
To select text in the code editor, you can press SHIFT plus a navigation key. 
This operation selects the text from the current cursor position to the new 
cursor position.
The table below lists the other text selection operations.

A.3 Finding text

Operation Keys

Move the cursor to the first character of the current line HOME

Move the cursor to the last character of the current line END

Move the cursor to the first character in the code editor CTRL+HOME

Move the cursor to the last character in the code editor CTRL+END

Move the cursor to the previous token1 CTRL+ARROW LEFT

Move the cursor to the next token CTRL+ARROW RIGHT

Move the cursor to the first visible line in the code editor CTRL+PAGE UP

Move the cursor to the last visible line in the code editor CTRL+PAGE DOWN

Move the cursor to the matching parenthesis CTRL+]

1. A token is a constructing element of the BASIC programming language, such as a command, an operator, a 
variable name or an expression.

Operation Keys

Select all text in the code editor CTRL+A

Select the current token CTRL+SHIFT+W

Select a block of text from the cursor position up SHIFT+ALT+ARROW UP

Select a block of text from the cursor position down SHIFT+ALT+ARROW DOWN

Select a block of text from the cursor position to the left SHIFT+ALT+ARROW LEFT

Select a block of text from the cursor position to the right SHIFT+ALT+ARROW RIGHT

Select a block of text from the cursor position to the previous token CTRL+SHIFT+ALT+ARROW 
LEFT

Select a block of text from the cursor position to the next token CTRL+SHIFT+ALT+ARROW 
RIGHT

Operation Keys

Find and replace text CTRL+F

Start an incremental search CTRL+I

Do an incremental search backwards CTRL+SHIFT+I
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A.4 Changing text

A.5 Deleting text

A.6 Inserting a new line

A.7 BASIC commands and arguments

A.8 Clipboard and undo/redo operations

Operation Keys

Increase the line indent of the current line or the selected text TAB

Decrease the line indent of the current line or the selected text SHIFT+TAB

Change the character right of the cursor or the selected text to uppercase CTRL+SHIFT+U

Change the character right of the cursor or the selected text to lowercase CTRL+U

Toggle between inserting text or overwriting text INSERT

Swap the characters left and right of the cursor CTRL+T

Swap the token at the cursor position with the next token CTRL+SHIFT+T

Swap the current line and the next line CTRL+SHIFT+ALT+T

Operation Keys

Delete the current line CTRL+SHIFT+L

Delete the text from the cursor to the next token CTRL+DEL

Delete the text from the previous token to the cursor CTRL+BACKSPACE

Operation Keys

Insert a new line above the current line CTRL+ENTER

Insert a new line below the current line CTRL+SHIFT+ENTER

Operation Keys

Insert a BASIC command CTRL+SPACE

Show the argument information of a command CTRL+SHIFT+SPACE

Operation Keys

Undo the last operation CTRL+Z

Redo the last operation CTRL+Y

Cut the selected text to the clipboard CTRL+X or SHIFT+DEL

Copy the selected text to the clipboard CTRL+C or CTRL+INS

Paste the text on the clipboard CTRL+V or SHIFT+INS

Cut the current line to the clipboard CTRL+L



Scrolling Appendix A Shortcut keys in the code editor

91

A.9 Scrolling
Operation Keys

Scroll the contents of the code editor one line up CTRL+ARROW UP

Scroll the contents of the code editor one line down CTRL+ARROW DOWN
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Revision history
A manual revision code appears as a suffix to the catalog number on the front 
cover of the manual.

The following table lists the changes made to the manual during each revision.

Cat. No. I56E-EN-03

Revision code Date Revised content

01 August 2008 First version

02 July 2010 Second version
Addition of MC64 to Devices and Units, see sections 3-2, and 3-6. All 
tables and notes that apply have also been updated.
Addition of EtherCAT, see section 3-6-6.
Addition of Terminal Window, see section 4-7-8.

03 May 2011 Third version
Addition of Compatibility Settings, see section 2-5 
Addition of EtherNet/IP Settings, see section 3-2-3-7 
Addition of Axis Offset, see section 3-5-6
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